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Foreword
The National Curriculum Framework–2005 (NCF–2005) recommends
bringing work and education into the domain of the curricular, infusing
it in all areas of learning while giving it an identity of its own at relevant
stages. It explains that work transforms knowledge into experience and
generates important personal and social values such as self-reliance,
creativity and cooperation. Through work, one learns to find one’s place
in society. It is an educational activity with an inherent potential for
inclusion. Therefore, an experience of involvement in productive work
in an educational setting will make one appreciate the worth of social
life and what is valued and appreciated in the society. Work involves
interaction with material or other people (mostly both), thus, creating
a deeper comprehension and increased practical knowledge of natural
substances and social relationships.
Through work and education, school knowledge can be easily linked
to learners’ life outside the school. This also makes a departure from
the legacy of bookish learning and bridges the gap between the school,
home, community and workplace. The NCF–2005 also emphasises on
Vocational Education and Training (VET) for all those children, who wish
to acquire additional skills and/or seek livelihood through vocational
education after either discontinuing or completing their school education.
VET is expected to provide a ‘preferred and dignified’ choice rather than
a terminal or ‘last-resort’ option.
As a follow-up of this, NCERT has attempted to infuse work across
subject areas and also contributed in the development of the National
Skill Qualification Framework (NSQF) for the country, which was
notified on 27 December 2013. It is a quality assurance framework that
organises all qualifications, according to levels of knowledge, skills and
attitude. These levels, graded from one to ten, are defined in terms of
learning outcomes, which the learner must possess regardless of whether
they are obtained through formal, non-formal or informal learning.
The NSQF sets common principles and guidelines for a nationally
recognised qualification system covering schools, vocational education
and training institutions, technical education institutions, colleges
and universities.
It is under this backdrop that Pandit Sunderlal Sharma Central
Institute of Vocational Education (PSSCIVE), Bhopal, a constituent of

NCERT, has developed learning outcomes based modular curricula
for vocational subjects from Classes IX to XII. This has been developed
under the Centrally Sponsored Scheme of Vocationalisation of Secondary
and Higher Secondary Education of the Ministry of Human Resource
Development.
This textbook takes care of generic skills embedded in various job roles
in a comprehensive manner and also provides more opportunities and
scope for students to engage with these common and necessary skills,
such as communication, critical thinking and decision making in different
situations pertaining to different job roles.
I acknowledge the contribution of the development team, reviewers
and all institutions and organisations, which have supported in the
development of this textbook.
NCERT would welcome suggestions from students, teachers and
parents, which would help us to further improve the quality of the material
in subsequent editions.

Hrushikesh Senapaty
Director
National Council of Educational
Research and Training

New Delhi				
June 2018					
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About the Textbook
Employability skills can be defined as soft skills, which employers look
for in a potential employee. These are the skills that equip employees
to carry out their responsibilities to the best of their abilities, ensuring
client satisfaction. For example, the ability to explain what someone
means in a clear and concise way through written and spoken means
helps in fostering better relationship with the client or customer.
Similarly, handling stress that comes with deadlines for completing
a work or target and ensuring that a person meets the deadlines can
be done through effective self-management training. It can also be
done by working cordially with other people from different disciplines,
backgrounds and expertise to accomplish a task or goal.
In today’s digital age, employers expect that employees are able to make
use of elementary functions of information and communication technology
to retrieve, access, store, produce, present and exchange information in
collaborative networks using the Internet.
Students need to develop entrepreneurial skills so that they can
develop necessary knowledge and skills to start their own businesses,
thus, becoming ‘job creators’ rather than ‘job seekers’. Potential employees
need to develop green skills, which are technical skills, knowledge, values
and attitudes needed in the workforce to develop and support sustainable
social, economic and environmental outcomes in business, industry and
community. Thus, as a student, one is expected to acquire a range of
skills so that the person can meet the skill demands of the organisation
that one would be working for or to set up and run one’s own business.
This textbook on ‘Employability Skills’ covers communication,
self-management,
information
and
communication
technology,
entrepreneurial and green skills. It has been developed as per the learning
outcome-based curriculum. The employability skills are embedded in
the Qualification Packs of the different job roles in various sectors under
the National Skill Qualification Framework. The textbook aims to provide
learning experience through a blended approach of text and video-based
interactive e-learning lessons. Running these e-learning lessons in
classrooms would require a computer with Internet connection, projector

and sound system, which the school needs to provide to teachers and
students. The teachers will guide the students to actively participate
in class. The students can ask and answer questions, and follow the
instructions to complete the exercises and activities.
Vinay Swarup Mehrotra
Professor and Head
Curriculum Development and Evaluation Centre
and National Skill Qualification Framework Cell,
PSSCIVE, Bhopal
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Communication
Skills

Introduction
Communication is a two-way process through which
information or message is exchanged between
individuals using language, symbols, signs or
behaviour. Speaking, listening, reading and writing
are the parts of communication, which help us to
understand others. To learn a language, one needs
to develop four key skills, namely listening, speaking,
reading and writing as shown in Figure 1.1.

Figure. 1.1: Key communication skills

Speaking more than one language can help a person
communicate well with people around the world.
Learning English can help one communicate with
people who understand English, besides the language
the person has been exposed to since birth. The ability
to communicate effectively is an essential skill in today’s
information age. Communication skills are needed to
communicate effectively with people and customers.

This Unit on communication skills aims to help you
to understand the importance of various aspects of
communication and develop effective communication
skills. You should try to learn as many languages as
possible as it will help you to understand others’ culture.
It will also equip you with knowledge and skills, which
are necessary to take advantage of the opportunities the
twenty-first century offers. If you know many languages,
you will be able to converse with people and read signage
while travelling to different places.
Communication involves a sender, who encodes and
sends a message through a channel, and a receiver,
who decodes the message and gives feedback as shown
in Figure 1.2. Feedback is important in communication
as it helps in knowing whether the receiver has
understood the message or not.

Figure 1.2: Elements of communication

Session 1: Active Listening
Effective communication involves skills that can be
utilised to send messages that are clear, concise and
accurate. Let us now try to understand what we mean
by clear, concise and accurate.
A clear statement is one which conveys the exact
message that you are trying to convey to the other person.
Here, we have two sentences. Now, which one do you
think is a clear statement?
(i) He went to his manager and said, “Please allow me
to reach office at 11 AM on Tuesday, 11 June 2019,
as I have an appointment with a dentist.”
(ii) He went to his manager and said, “Please allow me to
reach late to the office on Tuesday, 11 June 2019,
as I have an appointment with a dentist.”
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In the first sentence, you must have noticed that the
time is mentioned, which makes the statement clear.
A concise statement is appropriately brief or to the point.
Now, let us consider the two sentences given below.
(i) The manager replied, “Alright, you may come late.”
(ii) The manager replied, “Alright, you may come
late. But it is a matter of great concern that most
employees come late and you are also developing
the same habit.”
Now, you can see that in the second sentence, there
is no need to tell the employee about the concern that
the employer had at the moment. This could have been
shared at a different forum or separately.
An accurate statement is one that is factual, i.e., its
correctness can be verified.
Now, once again, let us learn through examples.
(i) She informed the office that 50 per cent of the
books given for binding have been completed.
(ii) She informed the office that most of the books
given for binding have been completed.
Now, you can see that in the first sentence, a
measurable information is mentioned, which makes the
sentence accurate.
It is, thus, important to ensure that our communication
is clear, concise and accurate. Effective communication
skills help us to communicate the message correctly,
precisely and completely. Lack of communication skills
can result in confusion, frustration, wasted effort and
missed opportunities.

Notes

Listening skill
Every effective conversation starts with listening.
Listening skill is one of the most important skills in
communication. It is important to learn to give undivided
attention to a person with whom a conversation is
taking place.
Given below are some reasons why listening
attentively is important.
• We listen to obtain information.
• We listen to understand.
Communication Skills

3

Notes

• We listen to enjoy.
• We listen to learn.
• We listen to build and maintain relationships.
• We listen to resolve conflicts.
Without the ability to listen attentively, messages
can be easily misunderstood. Thus, communication
breaks down and the sender of the message can easily
become frustrated or irritated.

Active listening
Active listening is an art, which comprises both a desire
to comprehend, as well as, offer support and empathy
to the speaker. It can affect your job effectiveness, the
quality of your relationship with others, and hence,
your overall well-being. Active listening allows you to
understand the problems and collaborate to develop
solutions. The various factors that affect active listening
are as follows.
• Eye contact: It is a form of body language.
It is one of the most important aspects in the
communication process. Maintaining an eye
contact with the person you are talking to sends
a signal to the speaker that “Yes, I am talking
to you or listening to you”. Avoiding eye contact
could mean that you do not want to listen to the
person speaking to you.

4

•

Gestures: These indicate to the speaker if you
are listening or not. Keep your hand and feet still
while talking to someone.

•

Avoiding distractions: You need to identify the
things that distract you. You must physically
remove the distractions in order to listen attentively.
For example, reducing the ringtone of your
mobile phone or switching it off while attending
a meeting or listening to someone will avoid
distraction. Another example is that you should
avoid glancing at the wristwatch frequently.

•

Giving feedback: Feedback can be positive or
negative. But in both the cases, one needs to be
polite so that the person to whom the feedback is
being given is not hurt or offended.
Employability Skills – Class XII

Stages of active listening
The best kind of listening is ‘active listening’. It happens
when you hear, understand, respond and remember
what is being said. The five stages of active listening are
as follows.
1. Receiving: It involves listening attentively.
2. Understanding: It is an informed agreement
about something or someone.
3. Remembering: It refers to the retrieval or recall
of some information from the past.
4. Evaluating: It is about judging the value, quantity,
importance and amount of something or someone.
5. Responding: It is about saying or doing
something as a response to something that has
been said or done.

How to ensure active listening?
You can remember the acronym ‘RESPECT’ to ensure
active listening (Table 1.1). Now, let us see what each
letter stands for.
Table 1.1: Active listening
R

Remove distractions that may hamper listening. For
example, reducing the volume of television, radio or mobile
phone while talking to a person.

E

Eye contact refers to looking at the speaker while listening.

S

Show that you are listening attentively to the speaker
through gestures.

P

Pay attention and focus on what the speaker is saying.

Communication Skills
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E

Empathise and feel the emotions of the speaker. Empathy
is the ability to share someone’s feelings or experiences
by imagining what it would be like to be in that person’s
situation.

C

Clarify doubts. Ask questions to clarify doubts.

T

Tune yourself to the timing of the speaker, i.e., wait for the
speaker to finish, and then, respond.

You have learned about various factors and stages
of active listening. Now, let us try to understand how to
overcome these barriers (Table 1.2).
Table 1.2: Overcoming barriers to active listening
Factors

How a factor can
become a barrier?

Being pre‑occupied When pre-occupied,
you may not be
listening to a person
carefully.

How to overcome the barrier?
Do not let emotions take over your mind.
Keep away phones and digital devices.

Noise and visual
distractions

You may not be able to
hear the other person
clearly in a noisy
environment.

Create a conducive environment to avoid
misinterpretations and distractions.

Past experiences
or mindset

You may have
developed biases or
prejudices based on
past experiences and
interactions.

Avoid developing biases and be objective in
your approach when interacting with others.

Personal factors

Your personal feelings Allow the other person to finish speaking,
may affect your
and then, respond.
listening, for example,
your preconceptions
about the other person.

6
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Practical Exercise

Notes

The teacher will facilitate these activities by showing you the
e-learning lesson at http://www.psscive.ac.in/Employability_
Skills.html. This will include videos and e-content for the above
topics, as well as, detailed instructions for some activities
given below.
Initial thinking activity
After watching the initial video in the e-learning lesson for this
topic, write the answer of the question — why is it important to
listen actively?
Activity 1

Group discussion
Factors affecting active listening
Material required
Notebook, pen, etc.
Procedure
• Form groups of three students each.
• Each group selects any one of the factors (as given in
Table 1.2), which acts as a barrier to active listening.
• Discuss how it can affect or become a barrier to active
listening in the following situations.
(i) Family gathering for a wedding ceremony
(ii) At a busy retail store
(iii) Team discussion during sports day at school
(iv) Birthday celebration of a friend
• Each group shares its experiences and ways to overcome
these barriers.
Activity 2

Poster making
Active listening
Material required
Chart paper, pencil, sketch pens, etc.
Procedure
• Make a poster on either of the below mentioned scenarios
using the acronym RESPECT, which you have studied in
this Session for practising active listening.
(i) Depicting a conversation between two friends
(ii) Parent–child conversation
Activity 3
Role-play
Negative effects of not listening actively
Material required
Notebook, pen, etc.
Procedure
Scenario: Kapil works in an organisation. His manager Sunita
is having a discussion with him regarding a marketing plan. As
Communication Skills
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soon as Kapil enters the meeting room, he sits in a slouched
position. He has not kept his phone on silent mode and keeps
looking at it frequently. Even though he is listening to Sunita,
his thoughts seem to be elsewhere. At the end of the session,
Sunita feels Kapil is disinterested and hands over the marketing
plan to some other employee.

Check Your Progress
A. Multiple choice questions
Read carefully the questions given below and choose the
correct option.
1. You work at the front desk of a telecom company.
A customer approaches you while you are working.
The customer has a query regarding a bill. What would
you do?
(a) Not pay attention to the customer
(b) Keep the work aside and help the customer
(c) Continue doing your work while talking
inattentively to the customer
(d) Ask the customer to talk to someone else
2. Which of the following can be a barrier to
active listening?
(a) Noisy environment
(b) Not maintaining an eye contact with the speaker
(c) Not being attentive
(d) All of the above
3. Which of the following is not a stage of active listening?
(a) Receiving
(b) Understanding
(c) Non-responding
(d) Evaluating
4. What are the characteristics of an ideal message?
(a) Clear
(b) Concise
(c) Accurate
(d) All of the above
B. Short answer question (80–100 words)
1.

Write down a situation you faced at school, wherein,
you overcame a barrier and practised active listening.

What have you learnt?
After completing this Session, you will be able to:
• identify the barriers to active listening.
• identify the stages of active listening.
• follow the steps towards removing barriers for
active listening.
8
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Session 2: Parts

of

Speech

Introduction
In any language, parts of speech are the categories of
words based on their function within a sentence. These
are the ‘building blocks’ of a language.
When we speak or write, we use sentences to
express ourselves. Therefore, sentences are important.
A ‘sentence’ is a group of words that communicates
a complete meaning, thought or action. For example,
Raju goes to school.
A group of words, which does not make complete
sense, is known as a ‘phrase’, for example, Raju goes.
A sentence always begins with a capital letter, and
ends with a full stop, question mark or exclamation
mark. Read aloud the examples given below.
• Did you work on your project?
• I completed it yesterday.
• That is good!

Using capitals
We know that all sentences begin with a capital letter. It
is easy to know what to capitalise if you remember the
acronym ‘MINTS’. MINTS is a set of simple rules that
help you to capitalise words correctly. Each letter in the
word MINTS refers to one capitalisation rule as shown
in Table 1.3.
Table 1.3: Capitalisation rules
Alphabet

Rule

Example

M

I

N

T

S

Months

I

Names

Titles

Capitalise
the first
letter in
the names
of all
months.

Capitalise
the letter
‘I’ when
used as a
word.

Starting letter of
sentences
Capitalise the
first letter in
every sentence.

Capitalise the
first letter in the
names of people,
places, rivers,
seas and oceans,
mountains,
islands and days.
I will go to Every
This Tuesday,
college in day, I play Vidya is in
June.
tennis
Rajasthan.
with him.

Communication Skills

Capitalise the
first letter in
the titles used
before people’s
names.

Dr Shah and
Mr Patel work
together.

The cat ran out
of the house.
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Punctuation
There are 15 basic punctuation marks or signs used
in English. These include full stop or period, comma,
question mark, exclamation mark, apostrophe, colon,
semi‑colon, dash, hyphen, parenthesis, quotation mark,
bracket, brace, ellipsis and bullet point (Table 1.4).
Table 1.4: Punctuation marks
Punctuation
mark

Sign Use

Example

Full stop

.

Comma

,

This is a sentence. This is
another sentence.
Sanjay is a Professor.
His patients call him
Prof. Sanjay.
After the waiter gave me the
menu, I ordered food.
I bought apples, oranges
and grapes.

Question
mark

?

Exclamation !
mark
Apostrophe

(’)

It shows the end of a sentence. It is
also used to show short form of long
words. For example, ‘Professor’ can be
shortened as Prof., when used as
a title before a name.
Sometimes, we use comma to indicate
pause in a sentence.
We can also use comma to separate
items when we are listing more than
two items in a row.
We use question mark at the end of
a question.
We use an exclamation mark at the
end of a word or sentence to indicate
a strong feeling, such as surprise,
shock or anger.
We use an apostrophe followed by
an ‘s’ to show that something belongs
to someone.
We also use an apostrophe to indicate
the shortened form of some words in
informal speech.

What is your designation?
How much is your work
experience?
What a pleasant surprise!
You are late!
That is Divya’s desk.
Are these Abdul’s books?
Let’s go instead of Let us go!
He isn’t here instead of He is
not here.

Basic parts of speech
The different types of words we use in
sentences are called parts of speech. The
basic parts of speech are nouns, pronouns,
adjectives, verbs and adverbs (Table 1.5).

Figure 1.3: Basic parts of speech

10
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Table 1.5: Basic parts of speech
Parts of
speech

What they do

Example sentence

Example
words

Noun

Nouns are words that refer to In the sentence: “Reema wrote
a person, place, thing or idea. a letter.” Both Reema and
They are ‘naming words’.
letter are nouns.

Dog
India
Sanjay

Pronoun

A pronoun is a word used in
place of a noun.

In the second sentence:
“Reema wrote a letter. She is
tired.” She is used in place
of the noun Reema. It is a
pronoun.

I
They
He
You

Adjective

Adjective is a word that
describes other words.

In the sentence: “Reema wrote
a long letter.” Long is an
adjective that describes the
noun ‘letter’.

Small
Blue
Sharp
Loud

Verb

Verb is a word that shows
action.

In the sentence: “Reema wrote
a letter.” Wrote is a verb. It
tells what action Reema did.

Run
Eat
Think
Sit

Adverb

Adverb is a word that adds
meaning to a verb, adjective,
or other adverb. It answers
the questions — how? how
often? when? and where?

In the sentence: “Reema
quickly wrote a letter.” Quickly
is an adverb. It tells us how
Reema did the action (writing).

Easily
Always
Inside
Before

Sometimes, the same words can be used differently.
Will you book a movie for 3 pm?

‘Book’ is used as an adverb.

I need to find my English book.

‘Book’ is a noun.

His total cricket score was 145.

‘Total’ is an adjective.

That is totally awesome.

‘Totally’ is an adverb.

She is always watching a football match.

‘Football’ is an adjective.

She got a new football for her birthday.

‘Football’ is a noun.

The experienced sailor was able to hold up the
sail despite heavy storm.

‘Sail’ is a noun.

Satish was able to sail through despite the storm.

‘Sail’ is a verb.

Kapil promised his father that he will be a good boy.

‘Promised’ is a verb.

Kapil was unable to keep the promise given to his father. ‘Promise’ is a noun.
Communication Skills
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Let us now see how these words are used. Read out
aloud the sentence given below.
Wow! Reema went to the studio and met a famous actor.
We already know that Reema, studio and actor are
nouns. Famous is an adjective because it describes the
actor (noun) and the words went and met are verbs
because they describe an action.
What about the remaining words in this sentence —
wow, to, the, and? What are these words called? We use
such supporting words to join the main parts of speech
together and to add information to the sentences that
we frame. Let us now look at supporting parts of speech.

Figure 1.4: Supporting parts of speech

Supporting parts of speech
Along with the main ‘Parts of Speech’, there are some
more words we need for connecting words, phrases,
clauses or sentences. Such words are called ‘supporting
parts of speech’. (Figure 1.4 and Table 1.6).
Table 1.6: Supporting parts of speech
Supporting
parts of speech

Use

Example

Articles

• The words ‘a’, ‘an’ and ‘the’ are
known as articles.
• Articles are, generally, used
before nouns.
• ‘An’ is used before words with a
vowel (a, e, i, o, u) sound.
• ‘A’ is used before nouns starting
with a consonant (all except
those starting with a, e, i, o and u)
sound.
• ‘The’ is used to refer to specific or
particular words.

The car stopped suddenly because
a cat ran in front of it.
A book
An apple
An umbrella
The sun

12

Employability Skills – Class XII

Conjunctions

Conjunctions are words that join
two nouns, phrases or sentences.
Some common conjunctions are
‘and’, ‘or’ and ‘but’.

Prepositions

• Prepositions connect one word
with another to show the
relationship between them. They,
usually, answer the questions
‘where’, ‘when’ and ‘how’.
• Some common prepositions are
‘on’, ‘at’, ‘under’ and ‘in’.
These words express strong
emotions, such as happiness,
surprise, anger or pain. They have
an exclamation mark at the end.

Interjections

Instead of – Sheela went to the
market. I went to the market.
Sheela and I went to the market.
Instead of – Do you want oranges?
Do you want apples?
Do you want oranges or apples?
The cat is on the roof.
The shop is at the end of the road.
Rahul is standing under the tree.
I live in Delhi.

Wow!
Oh!
Oh no!
Thanks!
Help!

Practical Exercise
The teacher will facilitate these activities by showing you the
e-learning lesson at http://www.psscive.ac.in/Employability_
Skills.html. This will include videos and e-content for the above
topics, as well as, detailed instructions for the following activities.
Initial thinking activity
After watching the initial video in the e-learning lesson for this
topic, write down what do you think was wrong with Seema’s letter.
Activity 1
Group practice
Identifying ‘parts of speech’
Material required
Notebook, pen, etc.
Procedure
• Form groups of four students each. Read aloud the
paragraph given below.
“on sunday, i have an appointment to meet dr. patel in delhi.
my house is near dr. patels clinic i went to a shop near the clinic
on friday to buy vegetables I bought potatoes onions carrots
and a cabbage dr. patel is a friendly man have you met him”
• This paragraph contains examples of parts of speech that
you have learnt about in this Session. Identify as many parts
of speech as you can and mark them. Discuss what was
difficult in this activity. Write the paragraph with correct
capitalisation and punctuation. A member of one group
Communication Skills
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volunteers and presents before the class what the group
marked. The person writes the paragraph on the classroom
board with the punctuations. The other students point out
the mistakes, if any.
Activity 2
Group practice
Constructing sentences
Material required
Notebook, pen, etc.
Procedure
• Form pairs of students.
• List the five basic parts of speech that you have
learnt in this Session.
• Select one of them and form two simple sentences, which
use these parts of speech. For example, if you have chosen
adjectives, form two sentences that have adjectives. For
each part of speech, a volunteer reads out the sentences
the group has framed.
• The other students say if it is correct or not.

Check Your Progress
A. Multiple choice questions
Read carefully the questions given below and choose the
correct option.
1.

What is a sentence?
(a) A group of ideas that form a complete paragraph
(b) A group of words that communicates a
complete thought
(c) A set of rules that we must follow to write correctly
(d) A set of words that contains basic
punctuation marks

2.

Which of these sentences is capitalised correctly?
(a)
(b)
(c)
(d)

3.

Which of these sentences is punctuated correctly?
(a)
(b)
(c)
(d)

14

I am Hungry.		
Divya and sunil are reading.
The bucket is Full of water.
She lives in Delhi.
Where are you going. 		
I have a pen a notebook and a pencil.
I am so happy to see you!
This is my house.
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Notes

B. Fill in the blanks
1.

Fill in the correct nouns and verbs as given at the top of
the table to complete the following sentences.
Nouns

Verbs

girl, girls, boy, milk, dog,
student

skipping, riding,
running, studying,
drinking, barking
(a) The ____________ is
_________________.
(b) The ____________ are
_________________.
(c) The ____________ is
_________________.
(d) Raju is ____________
_________________.
(e) The ____________ is
_________________.
(f)

The ____________ is
_________________.

C. Short answer question
1. Identify conjunctions and prepositions (remember,
conjunctions join two sentences, while prepositions
help answer the words ‘where’, ‘when’ and ‘how’) from
the list given below and write them in the following
columns.
		
Under, and, in, at, or, up
Conjunctions

Communication Skills
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What have you learnt?
After completing this Session, you will be able to:
• identify the basic parts of speech, such as nouns,
pronouns, adjectives, verbs and adverbs.
• use capitalisation and punctuation rules for sentences.
• explain the usage of parts of speech and identify them
in a sentence.
• identify supporting parts of speech, such as articles,
conjunctions, prepositions and interjections.

Session 3: Writing Sentences
Introduction
A sentence is a group of words, which together expresses
a complete idea that has meaning. A sentence is formed
by putting together a group of words in sequence. This
means that a sentence must be understood by others.
A sentence, typically, contains a subject and an object,
conveying a statement, question, exclamation, or
command. Writing is constructed by putting sentences
in sequence so that they are understandable.

Simple sentence
A simple sentence is one that has only one subject and
one predicate or has only one finite verb.

Complex sentence
A complex sentence is one, which consists of two or
more coordinate clauses, joined by a
coordinating conjunction.
As you have studied in English classes, almost all
sentences have a subject and a verb. Some also have
an object.
• A subject is a person or thing that does
an action.
• Verb describes the action.
• Object is the person or thing that receives the
action. For example, read aloud the simple
sentence — “Nisha sells a laptop”. Let us see the
different parts of the sentence in Figure 1.5.
16
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A subject is a
person or thing
that performs an
action. The question,
“who performed the
action?” will help you
find the subject. In
this sentence, ‘Nisha’
is the subject.

Nisha
Subject

Sells

a Laptop

Verb

Object

Verb describes the action. The
question, “what is the action?”
will help you find the verb. In this
sentence, ‘sells’ is the verb.

An object is the
person or thing that
receives the action.
The question, “who
received the action?”
will help you find
the object. In this
sentence, ‘a laptop’ is
the object.

Figure 1.5: Parts of a sentence

Read aloud the sentences given in Table 1.7 to
understand about subject, verb and object.
Table 1.7: Parts of a sentence
Sentence

Subject

Verb

Object

I wrote a letter.

I

wrote

a letter

He called the
customer.

He

called

the
customer

She packed the
product.

She

packed

the product

Dia and Sanjay
booked a cab.

Dia and
Sanjay

booked

a cab

Types of object
The object in a sentence can be either direct or indirect.
Direct objects are the ones directly ‘acted on’ by the
action word (verb). If we ask — “What does Nisha sell?”,
the answer is ‘laptop’, which is direct object. A direct
object answers the question ‘what?’.
An indirect object answers the questions, such as
“to whom” and “for whom”.
For example, in the sentence — “Abdul gave a gift
to his mother.” The verb is ‘gave’. What did Abdul
give? A gift. To whom did Abdul give the gift? To his
mother. Here, ‘gift’ is direct object and ‘his mother’ is
indirect object.
Some sentences only have direct objects, while some
have both direct and indirect objects.
Read out aloud the examples given in Table 1.8.
Communication Skills

17

Table 1.8: Direct and indirect objects
Sentence

Verb

Verb +
what?

Verb + by
whom/to
whom?

Direct
object

Indirect
object

Reema bought
stationery.

bought

stationery

stationery

Fatima and Sonia
played tennis.

played

tennis

tennis

He offered a coffee
to me.

offered

coffee

me

coffee

me

The manager
assigned us projects.

assigned

projects

us

projects

us

Types of sentences —
Category I
Active and passive sentences
What is the difference between
the following two sentences?
1. Sanjay broke the glass.
Figure 1.6: Types of sentences

2. The glass was broken
by Sanjay.

The action (verb) in both the
sentences is breaking of the
glass. But the ‘subject’ in both the
sentences is different. In the first
sentence, the subject (Sanjay)
does the action. In the second
sentence, the subject (the glass)
receives the action.
Read the sentences in
Figure 1.7: Active and passive sentences
Figure. 1.7 again.
Sentences, where the subject does an action, are
known to be in active voice.
Sentences, in which the subject receives an action,
are known to be in passive voice.

18
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Table 1.9: Active and passive sentences
Active voice

Passive voice

She wrote an email.

An email was written by her.

He opened the door for
the customer.

The door was opened by him
for the customer.

Mohan sold a bike.

The bike was sold by Mohan.

Examples of active and passive sentences
Active

Passive

I did not beat him.

He was not beaten by me.

Kapil made a profit
yesterday.

A profit was made by Kapil
yesterday.

The tiger was chasing
the deer.

The deer was being chased by
the tiger.

Types of sentences — Category II
There are mainly four types of sentences, i.e.,
declarative, interrogative, exclamatory and imperative.
Each of these have been described in Table 1.10.
Table 1.10: Types of sentences — Category II
Question or
Statement or
declarative sentence interrogative
sentence
It provides
information or states
a fact. It always
ends with a full stop
(.). This is the most
common type of
sentence.

This type of
sentence asks a
question. It always
ends with a question
mark (?).

Emotion, reaction or
exclamatory sentence

Order or
imperative
sentence

An exclamatory
sentence expresses a
strong emotion, such
as joy, sadness, fear or
wonder. It always ends
with an exclamation
mark (!).

These sentences
show an order,
command, request
or advice. It
can end with a
full stop or an
exclamation mark
(. or !).

Read aloud the examples given below.
I go to office.

Did you go to office?

I received the prize for
the best employee!

Go to office today.

It is very cold.

How is the weather?

Oh, it’s very cold!

Wear your sweater.

I completed my
project.

Did you complete
your project?

I completed my project!

Complete your
project.

Communication Skills
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Examples of types of sentences — Category II
Sentence

Type

Where is my I-card?

Interrogative

My arms ache from planting
those saplings!

Exclamatory

Reading mythology will make Declarative
you more aware.
Come with us right now.

Imperative

No way! I don’t want a tattoo!

Exclamatory

Get out of the bed immediately! Imperative

Figure 1.8: Types of sentences — Category II

You can see that each of these sentences have a
different purpose.

Paragraph
A group of sentences forms a paragraph. While writing
a paragraph, make sure the sentences have a common
idea. When you want to write about a different idea, make
a new paragraph. For example, if you are writing about
your school, the first paragraph can be of sentences
about the name, location, size and other such details. In
the next paragraph, you can use sentences to describe
what you like about your school.
I go to Government Higher Secondary School, Balachadi.
It is not a very big school but has many good teachers.
There are about 100 students in my school. My school is
on the main road, very close to the city railway station.
I love going to school and learning about new things. My
school has a small playground, where I play cricket with
my friends after the classes are over. It has a library also.
I love my school.
20
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Practical Exercise

Notes

The teacher will facilitate these activities by showing you the
e-learning lesson at http://www.psscive.ac.in/Employability_
Skills.html. This will include videos and e-content for the
above topics, as well as, detailed instructions for some activities
given below.
Initial thinking activity
After watching the initial video in the e-learning lesson for this
topic, write if you think Sanjay and Dia were able to frame correct
sentences.
Activity 1
Pair work
Making sentences
Material required
Notebook, pen, etc.
Procedure
• Form pairs of students.
• First, write three sentences having direct objects.
• Then, write three more sentences, containing both direct
and indirect objects.
• Use different colours to mark the different parts of each
sentence (subject, verb and object).
Activity 2
Pair work
Active and passive voice
Material required
Notebook, pen, etc.
Procedure
• With same pairs as above, write a paragraph on any topic.
The paragraph should have at least two sentences in active
voice and two in passive voice. One student reads out the
paragraph that the person has written before the class.
• The class gives the feedback.
Activity 3
Pair work
Types of sentences
Material required
Notebook, pen, etc.
Procedure
• With the same pairs as above, make a list of minimum eight
sentences. These should have at least two sentences of each
type: declarative, interrogative, exclamatory and imperative.
• For each type of sentence, different volunteers read out
their sentences before the class.
• The class, then, gives feedback on the correctness of
the sentences.
Communication Skills
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Check Your Progress
A. Multiple choice questions
1.

Identify the subject in the sentence, “The children
played football”.
(a) The children
(b) children played
(c) played
(d) football
2. Identify the object in the sentence, “The children
played football.”
(a) The children
(b) children played
(c) played
(d) football
3. Which of these sentences has/have both indirect and
direct objects?
(a) I am working on a presentation.
(b) She bought a blue pen.
(c) The girls played cricket.
(d) He wrote a letter to his sister.
4. Which of these sentences is/are in passive voice?
(a) They are watching a movie.
(b) The clock was repaired by Raju.
(c) He is sleeping in the room.
(d) My pet dog bit the postman.
B. Short answer questions
1.

Write one sentence of each type — statement, question,
exclamatory and order.

2.

Which job role do you wish to pursue? Write two
paragraphs (about 100–150 words) about that industry
and your career preferences. Make sure you follow
all rules about sentences and paragraphs that you
have learnt.

Practice work
• Practise speaking in complete sentences with
your classmates.
• Practise speaking with proper punctuations.
• Practise writing paragraphs on different topics.

What have you learnt?
After completing this Session, you will be able to:
• identify the different parts of a sentence.
• differentiate between active and passive voice.
• compose different types of sentences.
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Unit

2

Self-management
Skills

Introduction
Self-management, which is also referred to as
‘self-control’, is the ability to control one’s emotions,
thoughts and behaviour effectively in different situations.
This includes motivating oneself, and working towards
achieving personal and academic goals.
Students with strong self-management skills are
better at doing certain things well, such as coming to
class on time, paying attention, obeying teachers, parents
and elders, working with discipline, etc. It helps a person
to do better in studies or work. In order to do well at work
and life, in general, one must be able to manage and
improve oneself in various skills, including timeliness,
discipline, problem solving and work habits. To manage
oneself well, a person needs to develop the following.
• Positive thinking: to think that one can get things
done and be happy.
• Result orientation: to dream big and achieve the
desired or set results.
• Self-awareness: to be aware of one’s personality
traits and make the best out of one’s strengths.

Session 1: Motivation and Positive Attitude
Motivation and positive thinking can help us overcome
fears and take up new challenges. Similarly, optimism,
which is a mental attitude, reflecting a belief or hope,

2020-21

can lead to positive and desirable outcomes. It helps
us to achieve our dreams, continue working hard
towards achieving success and live a happy life with a
positive mindset.
“Optimism is the faith that leads to achievement. Nothing
can be done without hope and confidence.”
— Helen Keller

Motivation
Motivation is derived from the word ‘motive’. Thus,
directing behaviour towards certain motive or goal is the
essence of motivation. An individual’s motivation may
come from within (intrinsic motivation) or be inspired
by others or events (extrinsic motivation).

Intrinsic motivation
It includes activities for which there is no apparent reward
but one derives enjoyment and satisfaction in doing
them. It occurs when people are internally motivated
to do something because it brings them pleasure. They
think it is important or feel what they are learning is
significant. Incentives related to the motive or goal can
satisfy one’s needs.

Extrinsic motivation
It arises because of incentives or external rewards. Lack
of motivation or incentives may lead to frustration, for
example, employees who are kept on contractual basis for
a long time may get frustrated and leave an organisation.

Positive attitude
A positive attitude makes a person happier, and helps
build and maintain relationships. It even increases one’s
chances of success. In addition, it can help the person
make better decisions. People, who maintain a positive
or optimistic attitude in life situations and challenges,
are able to move forward than those with a negative
attitude. Positive attitude helps improve mental and
physical health.

Ways to maintain positive attitude
It can take a little time and effort to build a positive
attitude (Figure 2.1). Following are some ways that can
help one maintain a positive attitude.
Employability Skills – Class XII
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•

Start the day with a morning routine. Say positive
affirmations, smile often and think about the
tasks to be accomplished during for the day.
• Feed the mind with positivity, read motivating
books, listen to music with uplifting lyrics, watch
inspiring movies, etc.
• Be proactive. A proactive person decides how one
must feel regardless of what may be going around
or what the day may bring.
• Focus on constructive and positive things. Do not
approach life with ‘problems’. Approach it with
‘solutions’.
• Learn from failures. Think what could have been
better and work towards the goals.
• Learn to focus on the present. Negativity mostly
stems out from anxiety of the past and
future events.
• Move towards your goals and
dreams. Be cheerful and work
Figure 2.1: Positive attitude
hard to achieve the dreams.
Here are some more techniques that can help you to
maintain a positive outlook in the long run.
• Physical exercise and fresh air: Following
a healthy lifestyle is essential for students.
Practising yoga, meditation and deep breathing
exercises help improve blood circulation and relax
the body. Taking a walk or playing in the park
helps one to get a lot of fresh air, which helps in
becoming more active.
• Healthy diet: A healthy and balanced diet is
important for a healthy body and mind. Eating a
balanced diet, such as daal, roti, green vegetables
and fruits provides the strength required to do
daily work efficiently.
• Organise academic life: By keeping class
notes organised, completing assignments on
time and keeping track of all deadlines, stress
can be reduced to a great extent. When you are
not stressed, you can channelise your mind to
achieve the goals.
Self-management Skills
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•

Adequate sleep: A good night sleep for at least
seven hours is important so that the mind and
body can get recharged to function better the
next day.
• Holidays with family and friends: Visiting a
relative’s place, such as grandparents’ house or a
new place during summer vacation can help one
break the the monotonous normal routine and
come back refreshed.
Positive attitude is of immense value in a student’s
life. There are various situations that the student will
encounter in life, wherein staying positive will keep
the child going. The most common example would be
during exam results. At times, a student does not get
the desired result in exams. But it is important not to
lose hope, accept the result gracefully and work harder
with a positive attitude for the next exam.
Even during an interview for a dream job, a
candidate may not get selected in the first attempt.
However, with a positive attitude and persistent
efforts, all dreams can be achieved. Thus, it becomes
imperative for a child to learn to practise positive
attitude in life at all times.

What is stress and how to manage it?

Figure 2.2: Stress

Stress is a state of feeling upset, annoyed and hopeless.
There are times when we feel nothing is working right,
we are not able to achieve our goals and feel hopeless.
During such times, if we manage and control our
emotions, it helps us to sail through. Some of the ways
to manage stress are given below.
• Stay positive and analyse what is going wrong in
a certain situation. Resolving the situation is easy
once understood.
• Maintain an accomplishment sheet and enter
even small achievements.
• Keep your thoughts in present. Pondering over
past issues makes us feel upset and helpless.
• Talk to friends and family for comfort.
• Practise meditation and yoga.
• Whenever you feel negative thoughts are taking
over, take a look at your accomplishment sheet.
Employability Skills – Class XII
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By managing stress effectively and maintaining a
positive attitude, one can overcome any challenge and
achieve heights in career. Managing stress effectively helps
one maintain a healthy work – life balance.

Notes

Practical Exercise
The teacher will facilitate these activities by showing you the
e-learning module for this lesson via http://www.psscive.ac.in/
Employability_Skills.html. The module will include videos and
e-content for the above topics, as well as, detailed instructions
for some activities given below.
Activity 1
Role‑play
Avoiding stressful situation
Material required
Pen or pencil, notepad or sheets of paper, etc.
Procedure
• Form groups of three Choose any one scenario from below.
Situation 1: You have missed your school bus and are
getting late. What will you do? Will you panic or call for
help or try to find a way?
Situation 2: You have to perform your best in a cricket
match so that you get a chance to play for your school
at the national level. You have been anxious (worried or
stressed). Will you lose your sleep worrying about it or go
to the field and practice?
• Prepare a skit and perform within your groups. Two
members will perform the skit and one member will
observe and share the feedback.
Activity 2
Self-reflection
Material required
Pen or pencil, etc.
Procedure
• Complete the table given below by listing situation(s) that
cause negative thinking, for example, not performing well
in an exam. List how you can manage the situations.
Situations causing
negative thinking

How to turn around
for positivity

Self-management Skills
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Check Your Progress
A. Short answer questions
1.

Describe the ways you can make positive thinking a
habit in life.

2.

List the importance of positive thinking. Describe how
it can help someone achieve one’s goals.

What have you learnt?
After completing this Session, you will be able to:
•
•
•
•
•

explain the meaning of motivation.
describe the type of motives.
differentiate between intrinsic and extrinsic motivation.
describe the meaning of positive attitude.
identify the steps for being positive in life.

Session 2: Result Orientation
Result orientation is a term used to describe a person’s
ability to recognise what results are important and the
steps needed to be taken to achieve them. It means to
focus on the result of an assigned task. If you know
the result you want to achieve, you can focus on the
efforts required to achieve it. Hence, result orientation
describes an individual or organisation that focusses on
outcome rather than the process that has been used to
produce a product or deliver a service.
An ideal employee needs to be proactive and result
driven. The person must always take necessary steps to
achieve the set goals or targets.

How to become result oriented?
(i) Set clear goals: Setting clear and accurate goals is
the first step one needs to take to meet the targets.
(ii) Prepare an action plan: An action plan describes
the way a person or an organisation will meet the set
objectives. It gives a detail of the steps to be taken
to achieve the target. Therefore, it consists of several
actions or steps that need to be taken, and changes
that need to be made. Each action, step or change
should include the following information.
Employability Skills – Class XII
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•
•
•
•
•

What changes will occur after the actions?
Who will carry out the changes?
When will the changes take place?
How long will the changes stay?
What resources are needed to carry out
the changes?
• Who should know and what should be
communicated?
(iii) Use the right resources and tools: One must
evaluate the resources and tools needed to
achieve those results and whether they are
available. For example, you may want to clear the
college entrance exam with 70 per cent marks.
Do you have the books to study for the exam?
If not, from where and how can you get them?

Notes

(iv) Communicate with mentors and peers: One
must talk to teachers, seniors and mentors for
help in setting realistic goals.
(v) Make a calendar: One must make a calendar to
monitor the progress at regular intervals.
(vi) Work hard: One must work hard and believe in
one’s dreams.

Goal setting
Goal setting helps us to understand what we want,
how to achieve it and how do we measure our success.
Writing a goal requires that we should understand its
purpose and objective. Let us try to understand how to
define a goal.
• Identify what the goal is about, for example,
customer satisfaction, speeding up the delivery
process, etc.
• How the goal would make a difference? For
example, will it enhance customer satisfaction,
will it result in an increase in demand of a product
or service, speed up the delivery process and
result in better loyalty and quality of the product.
Use the acronym SMART to set goals. Let us see what
each letter in SMART implies.
Self-management Skills
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•

S: Specific

Goals should be stated in specific terms. Vague goals
are difficult to attain. Specific goals give us a concrete
target. Hence, a goal should have a specific purpose.
•

M: Measurable

Goals should always be measurable. If we do not set
our goals in measurable terms, it is difficult to assess
whether we have achieved them or not.
•

A: Action-oriented

Goals do not just come true on their own. Effective goal
setting should include action-based steps that one will
follow to achieve the goal.
— Actions that I am already taking towards achieving
this goal
— Actions that I am not currently taking but will
take towards achieving this goal
— Actions that I am not currently taking and need
help to achieve the goal
— People and places from whom I can get help to
achieve the goal
•

R: Realistic

There are few things more damaging to our sense of
self-efficacy than setting ourselves up for failure. Goals
must always be realistically attainable.
•

T: Timely

Goals must have deadlines. However, deadlines may
change. But one must always set a deadline to get the
job done within a specified time limit.

Examples of result-oriented goals
Examples of result-oriented goals are as follows.
• A student may set a goal of scoring high marks
in an exam.
•

An athlete may run five miles a day.

•

A traveller may try to reach a destination city
within three hours.
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Practical Exercise
The teacher will facilitate these activities by showing you the
e-learning lesson at http://www.psscive.ac.in/Employability_
Skills.html. This will include videos and e-content for the above
topics, as well as, detailed instructions for the activity given below.
Activity 1
Pair and Share
Aim in life
Material required
Pen or pencil, notepad, etc.
Procedure
• Form pairs of students.
• Make a list of things that you can do well.
• Write your aim in life.
• Share your notes with your partner and discuss
your personal characteristics.
• One student volunteers and reads out the notes before
the class.
Here is the format to do the activity.
– List what you believe you are as a person by starting the
sentence with ‘I am’.
– Next, list what you can do well by starting the sentence
with ‘I can’ (I can sing well).
– List what you plan to do by starting the sentence with ‘I
will’ (I will train myself in classical music).
– Finally, state your aim in life. Start the sentence with ‘My
aim is’ (My aim is to become a singer).
– Making a list will help you to become self-aware and
result oriented.

Check Your Progress
1.

Fill in the table given below, which can help you to
prepare an action plan to achieve the set results.
Results I want
to achieve

I want to score
80 per cent in
quarterly exam.

What am I
doing for
achieving
the results?
I study for
two hours
daily.

What should I do
to achieve the
results?
I should study for
three hours and
practise sample test
papers.
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What have you learnt?
After completing this Session, you will be able to:
• identify ways to be result oriented.
• make an action plan.

Session 3: Self-awareness
Self-awareness is about understanding one’s own
needs, desires, habits, traits, behaviours and feelings.
Let us try to understand this with a short story.
“A monk slowly walks along a road when he hears a
galloping horse. He turns around to see a man riding the
horse moving in his direction. When the man comes closer,
the monk asks, “Where are you going?” To which the man
replies, “I don’t know, ask the horse” and rides away.

When we are not aware of ourselves, then we tread
in a direction about which we are not clear. Therefore, it
is important that we must be aware of ourselves. When
one becomes self-aware, the person starts to become
aware of everything and looks at things or situations
objectively. It plays a critical role in how we understand
ourselves and relate to others and the world around us.

Steps towards self-awareness
•

The first step for practising self-awareness is
gaining a greater awareness of one’s emotions
(Figure 2.3).

Figure 2.3: Various emotions a person experiences

•

The second step to practising self-awareness is
making a habit of tracking one’s feelings.
Employability Skills – Class XII

32

2020-21

•

The third step for practising self-awareness is
expanding one’s practice to areas of life beyond
the person’s feelings.

Notes

Personality and personality traits
Personality is a cluster of thoughts, feelings and
behaviours that make a person unique and different
from others.
Personality traits are defined as relatively lasting
patterns of thoughts, feelings and behaviours that
distinguish individuals from one another. Hence,
personality development is the development of an
organised pattern of behaviours and attitudes that
makes a person distinctive. Personality development
occurs by the ongoing interaction of temperament,
character and environment. Culture also plays an
important role in shaping personalities.
One’s personality also affects the person’s
relationships with others. A positive personality can
lead to better performance, increased productivity and
cordial relationships with others.
There are five parameters that describe an
individual’s personality. These five dimensions are also
called the ‘Big Five Factors’ and the model is referred
to as the ‘Five Factor Model’, which is abbreviated
as FFM (Figure 2.4).
• Openness: Individuals with openness to
experience are, generally, creative, curious, active,
flexible and adventurous. If a person is interested
in learning new things, meeting new people and
making friends, and likes visiting new places, the
person can be called open-minded.
•

Consciousness: Individuals, who listen to their
conscience, are self-disciplined, do their work on
time, take care of others before themselves and
care about others’ feelings.

•

Extraversion: Extroverts are individuals, who
love interacting with people around and are,
generally, talkative. A person, who can easily
make friends and make any gathering lively, is
confident and an extrovert.
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Notes

Figure 2.4: The ‘Big Five Factors’
or Five Factor Model

•

•

Agreeableness: Individuals having such a trait are,
generally, kind, sympathetic, cooperative, warm
and considerate. They accommodate themselves
in any situation. For example, people who help
and take care of others are, generally, agreeable.
Neuroticism: Neuroticism is a trait, wherein,
individuals show tendency towards anxiety,
self-doubt, depression, shyness and other similar
negative feelings. People, who have difficulty in
meeting others and worry too much about things,
show signs of neuroticism.

Common personality disorders
Personality disorders involve long-term patterns
of thoughts and behaviour that are unhealthy and
rigid. A personality disorder is a way of thinking,
feeling and behaving that deviates from worldly
expectations and causes distress, which lasts
over time.

Cluster A: Suspicious
People falling under this cluster always mistrust others
and are suspicious, even when there is no need to do
so. For example, Varsha is a homemaker. A maid has
been working at her house for two years. Despite having
CCTV cameras installed at home, Varsha is always
suspicious about the maid. She follows her all the time
and keeps a tab on her movements. This causes stress
between Varsha and her maid.
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Paranoid personality disorder: Paranoid
personality disorder is characterised by distrust
for others, including friends, family members
and partners. People with such a disorder mostly
hold grudges against others.
• Schizoid personality disorder: The term
‘schizoid’ refers to the natural tendency to direct
attention toward one’s inner life away from the
external world. A person with schizoid personality
disorder is detached and aloof, and prone to
introspection and fantasy. The person shows
little interest in forming personal relationships
and seems to be emotionally cold.
• Schizotypal personality disorder: People with
this type of personality disorder believe that they
can influence other people or events with their
thoughts. They often misinterpret behaviours.
This causes them to have inappropriate emotional
responses. They may consistently avoid having
intimate relationships.

Notes

Cluster B: Emotional and impulsive
This personality disorder is characterised by unstable
moods and behaviours, which lead to unhealthy and
unstable relationships, emotional instability and feeling
of worthlessness. For example, Sunny is a student
in a high school. Whenever he gets low marks, he is
depressed and fights with his friends. He, also, does not
try to learn from mistakes. His parents and teachers have
tried talking with him but he feels angry, worthless and
shouts at them.
• Antisocial personality disorder: People with
antisocial personality disorder disregard social
rules and obligations. They are irritating and
aggressive, and act impulsively. They tend to lack
guilt and fail to learn from experience. They may
lie, steal or abuse, and may also get addicted to
alcohol or drugs.
• Borderline personality disorder: People with
borderline personality disorder essentially lack a
sense of self-worth, and thus, experience feelings
of emptiness and fears of abandonment. There is a
Self-management Skills
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Notes

•

•

pattern of emotional instability, violent outbursts
and impulsive behaviour. Suicidal threats and
acts of self harm are common in people with such
a personality disorder. They may have difficulty
in dealing with stressful events.
Histrionic personality disorder: People with
histrionic personality disorder frequently try to
gain more attention by being overly dramatic. They
are extremely sensitive to criticism or disapproval,
and can be easily influenced by others.
Narcissistic personality disorder: People with
narcissistic personality disorder believe that
they are more important than others. They lack
empathy for other people and tend to exaggerate
their own achievements.

Cluster C: Anxious
This personality disorder is characterised by feelings of
worry, anxiety or fear, which have the potential to affect
one’s daily routine. For example, Shikha is an elderly
woman. She stays with her family. She has a habit of
washing her hands at least 20 times a day. Even after
washing her hands, she feels they are not clean, and
continues rubbing or washing them. She neither talks
to her grandchildren, nor does she participate in any
family activity.
• Avoidant personality disorder: People with this
type of disorder are socially inept, unappealing or
inferior, and constantly fear being embarrassed,
criticised or rejected. They avoid meeting others
and often experience feelings of inadequacy,
inferiority or unattractiveness.
• Dependent personality disorder: People with
such a disorder are characterised by lack
of self-confidence and an extra need to be
looked after. They need a lot of help in making
everyday decisions and surrender important
life decisions to the care of others. They are
heavily dependent on other people for their
emotional and physical needs, and thus,
usually, avoid being alone.
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Obsessive-compulsive personality disorder:
People with such a disorder strongly stick to
rules and regulations. They can be characterised
by a general pattern of excessive concern with
orderliness, perfectionism and attention to details.
They feel extremely uncomfortable when unable to
achieve perfection. They may even neglect personal
relationships to focus on making a project perfect.

Notes

Steps to overcome personality disorders
•
•
•
•
•

Talk to someone. Most often, it helps
to share your feelings.
Look after your physical health. A healthy body
can help you maintain a healthy mind.
Build confidence in your ability to handle
difficult situations.
Engage in hobbies, such as music, dance and
painting. These have a therapeutic effect.
Stay positive by choosing words like ‘challenges’
instead of ‘problems’.

Practical Exercise
The teacher will facilitate these activities by showing you the
e-learning module for this lesson via http://www.psscive.ac.in/
Employability_Skills.html. The module will include videos and
e-content for the above topics, as well as, detailed instructions
for the activity given below.
Activity 1
Group discussion
Self-awareness
Material required
Pen or pencil, notepad, chart paper, etc.
Procedure
• Form groups of three.
• Choose any one of the following situations and write down
the personality disorders associated with these.
— Kapil studies in a school. He disregards the rules set
by the school, is irritable and does not talk much with
either friends or family.
— Jaya has been feeling fearful and empty for the last
few days. She even tried to harm herself. What kind of
personality disorder is this? How can you help her?
Self-management Skills
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Check Your Progress
A. Multiple choice questions
Read the questions carefully and put a tick mark against the
correct option.
1. Which of the following is not a parameter to describe an
individual’s personality?
(a) Self-confidence
(b) Openness
(c) Neuroticism
(d) Agreeableness
2. Which of the following is characterised by an extreme
feeling of self importance?
(a) Narcissistic personality disorder
(b) Borderline personality disorder
(c) Dependent personality disorder
(d) None of the above
3. Ravi has feelings of emptiness, abandonment and
suicide. What type of personality disorder is this?
(a) Borderline
(b) Dependent
(c) Avoidant
(d) Obsessive
4. Mona is helping her sister to overcome a personality
disorder. What should she do?
(a) Talk to her sister
(b) Engage her in hobbies
(c) Help her build confidence
(d) All of the above

What have you learnt?
After completing this Session, you will be able to
• explain the meaning of personality.
• describe basic personality traits.
• describe common personality disorders.
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Unit

3

Information
and Communication
Technology Skills

Introduction
Information and Communication Technology, called
ICT in short, has become an integral part of our life.
One must develop the ability to use digital technology
and communication tools to access, manage, integrate,
evaluate, create and communicate. In this Unit, you
will learn about how to use spreadsheets and make
presentations using a software.

Session 1: Getting Started with Spreadsheet
How do people generally maintain their expenses? They
write down all expenses, such as school fee of their
children; grocery, gas and electricity bills; money spent
on festivals and clothes, etc., in a diary. Then, they note
down how much was spent on each item. Finally, the
total is calculated to find out how much they have spent
in a month. But nowadays, people who know how to use
a computer can use software to maintain an account of
their expenses.
Let us now learn about spreadsheets, which are used
for doing calculations on a computer.
A spreadsheet is an electronic document, which has
rows and columns. It is used to store data in a systematic
way and do calculations. For example, a grocery shop
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has many items. The shopkeeper keeps a track of the
total quantity of each item, quantity sold, cost and
selling price of each item, etc. All these details can be
maintained using a spreadsheet as shown in Table 3.1.
It will also help the shopkeeper do difficult calculations
easily, such as finding out profit or loss.
Table 3.1: Goods in a grocery store
Item

Total
Quantity Quantity Cost Selling
quantity sold (kg) left (kg) `/kg price
(kg)
`/kg

Wheat atta

250

115

135

28

31

Rice

160

57

103

46

50

Arhar daal

70

45

25

60

68

Sugar

200

145

55

40

45

Having understood what spreadsheets are, let us
now understand the types of spreadsheet.

Types of spreadsheet
There are many types of spreadsheet available that have
been created by different companies. Some of the most
popular ones are given in Figure 3.1.
Microsoft Excel

LibreOffice Calc

Google Sheets

Figure 3.1: Popular spreadsheet software

In this Session, we will be learning how to use
LibreOffice Calc. Most functions in different spreadsheets
are same. If you know how to use one, you can easily
use any other spreadsheet.

Steps to start LibreOffice Calc
1. The first thing you need to ensure is that
LibreOffice must be installed on your computer.
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2. Type LibreOffice Calc in the search bar
of Windows.
3. Select LibreOffice Calc from the search results as
shown in Figure 3.2. LibreOffice Calc will open a
blank sheet as shown in Figure 3.3.
4. You can start typing and entering data as soon as
you open the spreadsheet. However, to start using
the spreadsheet, first you need to understand
the components of a spreadsheet.

Components of a spreadsheet
In the spreadsheet, you can see a worksheet with cells
placed in rows and columns. Now, let us learn what
these are.

Figure 3.2: Select LibreOffice
Calc from the search results

1. A row is an arrangement of cells in a horizontal
(sleeping) manner. As shown in Figure 3.4, all
marks for maths are in row number 3.
2. A column is an arrangement of cells in a vertical
(standing) manner. As shown in Figure 3.4,
Rajvir’s marks are in column B.

Figure 3.3: LibreOffice Calc blank sheet

Figure 3.4: Rows and columns in a spreadsheet

3. A cell is a rectangle shaped box, where the row and
column meet. You can enter text, numbers, date,
formula, etc., in a cell. The cell that is selected
appears highlighted. In Figure 3.4, the selected
cell is B3 — the cell in column B on row 3 — and
it contains Rajvir’s marks for maths.
Information
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Whatever you type in, a cell
appears in the area called formula
bar as shown in Figure 3.5.
You also enter or edit data
and formula directly into the
Formula Bar.
4. The name box shows the
location of the selected cell.
The location of the cell is a
combination of column and
row. For example, A1, where
A is the column name and 1
is the row number.

Figure 3.5: Formula bar in a spreadsheet

5. A worksheet is a collection of cells in the form
of a grid (a network of lines that intersect each
other, making rectangles). When you open a
spreadsheet for the first time, you see a blank
worksheet with the name ‘Sheet1’.
6. A workbook is a spreadsheet that has one or
more worksheets.

Practical Exercise
Run e-learning lesson at http://www.psscive.ac.in/
Employability_Skills.html. This will include videos and
e-content for the above topics. Based upon the e-learning,
do the following activity.
Initial thinking activity
How do you think a shopkeeper maintains a record of
earnings and expenses?
Practical group exercise
Run the e-learning lesson to get details on how to
run the activity.
Activity 1
Group practice
Working with LibreOffice Calc
Material required
Pen or pencil, notebook and computer with LibreOffice Calc, etc.
Procedure
• Divide the class into groups, depending on the number
of computers available. Choose a group leader, who will
direct this activity.
• The leader will start LibreOffice Calc on the computer as
per the instructions given in the Session.
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• Each member of the group identifies one component of the
spreadsheet. The other members should give feedback as
to what is correct and what is not. The rest of the group
members can also make notes of the components identified
and make sure that none is left out.
• Write down the answers to the questions given below
in your notebook. Then, run the e-lesson to see
these questions.

Notes

Check Your Progress
A. Multiple choice questions
1.

A _____________ is an electronic document used to store
data in a systematic way and perform calculations just
like an expense sheet.
(a) spreadsheet
(b) worksheet
(c) workbook
(d) name box
2. Which of the following functions can be performed with
the help of spreadsheets?
(1) Maintaining records
(2) Creating videos
(3) Analysing data
(4) Performing financial calculations
(5) Writing letters
(a) 1, 2, 3, 4, 5
(b) 1, 3, 4
(c) 1, 3, 5
(d) 3, 4, 5
3. Match the columns, and then, choose the correct answer.
1. Grid of horizontal rows and
vertical columns

A. Row

2. Horizontal arrangement of cells
numbered 1, 2, 3, 4

B. Workbook

3. Where rows and columns meet
or intersect

C. Columns

4. Which contains one or more
worksheets

D. Cell

5. Vertical arrangement of cells
named A, B, C, D

E. Worksheet

(a) 1-E, 2-A, 3-B, 4-D, 5-C
(b) 1-E, 2-B, 3-C, 4-D, 5-A
(c) 1-A, 2-B, 3-C, 4-D, 5-E
(d) 1-E, 2-A, 3-D, 4-B, 5-C
4. A _______ is an arrangement of cells in a horizontal manner.
(a) column
(b) cell
Information
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What have you learnt?
After completing this Session, you will be able to
• explain the importance and usage of spreadsheet.
• list different spreadsheet applications.
• open LibreOffice Calc and create a spreadsheet.
• identify components (parts) of a spreadsheet.

Session 2: Performing Basic
Operations in a Spreadsheet
A spreadsheet can be used to perform various functions.
Let us see how to enter, edit, delete data and use data
functions effectively.

Steps to enter data
The steps to enter data in a particular cell in a
spreadsheet are given below.
1. Click on the cell where you want to enter data
as shown in Figure 1. For example, we click
cell A1.

Figure 1: Click on a cell

2. Type text or number. As you type, you can see
the data in the Formula Bar as well. Press Enter
when you complete typing.

Figure 2: Type text or number

3. The cursor is set on the next cell, in this case A2.
You can continue entering other data.

4. Notice that data in the cell will automatically
(by default) be left aligned (near the left edge of
the cell) as you have entered text as shown in
Figure 3. If you enter numbers, they are right
aligned in the cell. Remember that text is aligned
to the left of the cell, while number is aligned to
the right.

Figure 3: Text alignment
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5. You can enter a formula in a cell by starting
with ‘=’ equal-to symbol as shown in Figure 4.
This will do the calculations as given and display
the results.

Figure 4: Use ‘=’ for formula

Type of data
There are three main type of data — text, numbers
and formula. Nowadays, it is also possible to enter
pictures, audio, video and shapes in a spreadsheet.
Let us see what they are used for. Raghu owns a
shop. He keeps a record of all items, such as wheat,
rice, daal, sugar, etc. He enters the name of the
items, date of purchase, quantity purchased, cost
price, selling price, etc. Using a spreadsheet, he can
use text to enter names, numbers to enter quantity
and date to show when an item was purchased.

Editing data in a cell
If Raghu wants to name the item ‘Basmati rice’ instead
of ‘rice’, he can edit (correct) it in the spreadsheet.
There are various ways in which one can edit a cell
as shown in Figure 3.6.

Method 1
1. Double click on the cell you want to edit.
Then, type additional text in the cell or in the
Formula Bar.
2. Press Enter.

Figure 3.6: Editing text in a cell

Method 2
1. Click on the cell you want to edit.
2. Correct the text in the Formula Bar.
3. Press Enter.

Method 3
(If you want to completely change the text in the cell,
then do the following.)
1. Click on the cell.
2. Type the new text.
3. Press Enter.
Information
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Deleting data in a cell
You can delete the value stored in a
particular cell as shown in Figure 3.7.
The steps to delete data in a cell are
as follows.
1. Click on the cell.
2. Press Delete key on the keyboard.
This deletes the text entry of that
cell making it blank.

Figure 3.7: Deleting value in a cell

Selecting multiple cells
Now, if Raghu wants to delete the entire row related to
‘basmati rice’, he can select the entire row, and then,
press ‘Delete’. After selecting multiple cells, a function
will be performed on the cells that are selected. When
a single cell is selected it is called active cell. When a
number of cells is selected, it is called cell range. There
are several ways in which multiple cells can be selected
as shown in Table 3.2.
Table 3.2: Selecting multiple cells

To select an entire row, click the
row heading.

To select a full column, click the
column heading.

To select an entire worksheet, click the grey
rectangle on the upper left corner of
the worksheet.

To select a range of cells, click on the
starting cell, then hold down the mouse
button and drag it till you have selected
all the cells you want. Release the
mouse button.
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To select two or more rows that are not next to each other, select one row and hold down the
Control key, and then, select the next row as shown in the figure given below.

Saving the spreadsheet in various formats
After entering data, you can save the spreadsheet in the
same way as a Notepad or any other word file. Click File,
and then, Save as shown in Figure 3.8. This will open a
Save As dialog box. Type the file name and click Save.
The default Save as type is ODF Spreadsheet (.ods)
but you can save the spreadsheet in other types, such
as Microsoft Excel 2003 (.xls) as shown in Figure 3.9.

Figure 3.8: Saving the spreadsheet

Figure 3.9: Saving in other formats

Closing the spreadsheet
Once you have saved the data, you can
close the spreadsheet by clicking File, and
then, Close as shown in Figure 3.10.
Figure 3.10: Closing the spreadsheet

Information
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Opening a spreadsheet
Click File, and then, select Open. This will show a dialog
box with a list of existing files. Select the one you want
to open and click Open as shown in Figure 3.11.

Figure 3.11: Opening a spreadsheet

Printing the spreadsheet
To print a spreadsheet, you can click File, and
then, select Print from the drop-down or press
Ctrl+P on the keyboard as shown in
Figure 3.12.
A Print dialog box appears. Select the
printer, range of pages and number of copies
to be printed, and click OK as shown in
Figure 3.13.

Figure 3.13: Print dialog box

Figure 3.12: Printing the spreadsheet
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Practical Exercise
Run e-learning lesson at http://www.psscive.ac.in/Employability
_Skills.html. This will include videos and e-content for the above
topics. Based upon the e-learning, do the following activity.
Initial thinking activity
How do you think a shopkeeper will delete an entry in his record
book? How do you think a teacher deletes the name of a student,
who has left the school, from the register?
Practical group exercise
Run the e-learning lesson to get details on how
to run the activity.
Activity 1
Group practice
Working with data in LibreOffice Calc
Material required
Pen or paper, computer with LibreOffice Calc installed, etc.
Procedure
• Divide the class into groups, depending on the number of
computers available. Select a group leader.
• The leader opens a spreadsheet. Each member enters one’s
name, roll number and date of birth in the spreadsheet.
• Other members watch and give feedback on what is done
correctly and what could be done better.
• Your spreadsheet should look like the table given below.
Name

Roll No.

Date of Birth

Sushil Kumar

123

15/10/01

Meera Rao

124

26/12/03

Check Your Progress
A. Multiple choice questions
1.

The correct order of steps for entering data in a
spreadsheet is:

(a) type the data, click the cell and press Enter.
(b) click the cell, type the data and press Enter.
(c) press Enter, click the cell and type the data.
(d) click the cell, press Enter and type the data.
2. What will you do to select an entire worksheet in
a spreadsheet?
(a) Click the File tab and select properties from the list
(b) Click the grey row heading
(c) Click the grey rectangle in the upper left corner
of the spreadsheet
(d) Click the grey column heading
Information
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What have you learnt?
After completing this Session, you will be able to:
•
•
•
•
•
•

identify type of data.
open a spreadsheet.
enter, edit and delete data.
select multiple cells.
save and close a spreadsheet.
print a spreadsheet.

Session 3: Working with Data
and Formatting Text
Data stored in a spreadsheet can be used in calculations,
graphical representation and display of information. Let
us learn more about working with data.

Using spreadsheet for addition
Ms Sharma is a teacher and has just started using a
computer spreadsheet instead of her manual marks
register. She has entered the marks of her students
in various subjects as shown in Figure 3.14. Now, she
wants to find out the total marks for each student. What
should she do?
To find out the total marks for each
student, she needs to add the marks
in each subject. The symbol (operator)
used for addition in a spreadsheet is
‘+’ (plus). There are various ways to
do addition in a spreadsheet. Let us
explore them.
Figure 3.14: Students’ marks

Adding values directly

Figure 3.15(a): Entering formula

To do any calculation in a spreadsheet,
you need to use ‘=’ (equal‑to) symbol,
which tells the spreadsheet that a
formula has been entered. Only then
the spreadsheet will perform the
calculation and display the result.
Ms Sharma can add values directly
for each student, i.e., add the numbers
directly, such as ‘=73+89+78’ as shown
in Figure 3.15(a).
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When you type this in a cell and
press Enter, the result, i.e., 240 will be
displayed. Notice that the formula is
displayed in the Formula Bar as shown
in Figure 3.15(b).

Adding using cell address

Figure 3.15(b): Formula displayed in Formula Bar

Ms Sharma realised that she had
entered the wrong marks for English.
Now, she has to re-enter the total
formula. That is a lot of work since
there are 40 children in her class.
Spreadsheet gives you a better way to
calculate the total. Instead of using
direct numbers in the formula, you
can use cell addresses as shown in
Figure 3.16(a).
For example instead of entering
‘=73+89+78’, she can enter the cell
addresses ‘=B2+C2+D2’. This will also
give the same result. The advantage
here is that even if there is a change in
the marks, there is no need to type the
numbers again in the Total field as
shown in Figure 3.16(b).
All Ms Sharma needs to do is
change the English marks. The total
will automatically be calculated again.
No change has to be made to
the formula.
Notice in Figure 3.16(c), the
English score for Rohit has changed
from 73 to 66. The total changes
to 233 automatically, even though
there is no change in the formula
i.e., ‘=B2+C2+D2’ as shown in
Figure 3.16(c).

Figure 3.16(a): Formula using cell address

Figure 3.16(b): Total of three cells

Figure 3.16(c): Total remains the same

Using mouse to select values in a formula
Now, to write the formula, Ms Sharma has to find out
the cell address of each cell with marks and type it.
This requires some effort. Spreadsheet makes the task
Information
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easier for Ms Sharma. Using a mouse,
she can simply select the cell to be used
in the formula instead of typing the cell
addresses as shown in Figure 3.17. The
steps are as follows.
1. Type ‘=’ in the cell where you
want to calculate the total.
Figure 3.17: Using a mouse to select a cell
2. Click the cell, which has English marks for
Rohit. B2 will appear in the formula.
3. Type ‘+’.
4. Click the cell, which has maths marks for Rohit.
C2 will appear in the formula.
5. Type ‘+’.
6. Click the cell (D2), which has science marks
for Rohit.
7. Press Enter.
This will enter the same formula as before without
Ms Sharma having to type the cell addresses for marks
scored in each subject. This method is much easier,
especially, when there may be many subjects.

Using Sum() function

Figure 3.18(a): Using SUM() function

Spreadsheet also gives you some
functions that make it easier to do
calculations. To add numbers, we have
the Sum() function. This helps in adding
the numbers in separate cells or in a cell
range. In the example given in Figure
3.18(a) and (b), marks for Rohit are in
one row, one after the other. As shown
in Figure 3.18(a) and 3.18(b), the steps
to use the SUM() function are as follows.
1. Type ‘=Sum(' in E2 where you
want the total.
2. Now, click on English marks, i.e.,
B2, hold the left mouse button
and drag till science marks, i.e.,
D2. This will select the marks for
all three subjects.
3. Type ‘)’ and press Enter.

Figure 3.18(b): Steps to use SUM() Function
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This displays the results in cell number E2 and the
formula in the Formula Bar.
Copying and moving formula
Now, Ms Sharma has used the Sum()
function to calculate the total for
Rohit. Does she need to do the same
steps 40 times for all 40 students? No!
Spreadsheets provide a way to copy the
formula from one cell to another. The
Figure 3.19: Copy formula
values are automatically adjusted in the
new cells. The steps to copy a formula are as follows.
1. Click on the cell with the formula.
2. Right-click and select Copy as shown in
Figure 3.19 or press Ctrl+c on the keyboard. If
you wish to move the formula to a new cell, i.e.,
delete it from the existing cell, select Cut or press
Ctrl+x on the keyboard.
3. Click on the first cell, where you have to copy
the formula.
4. Keeping the left mouse button down, drag till you
reach the last cell, where you want the formula.
Release the left mouse button.
5. Right-click and select Paste as
shown in Figure 3.20 or press
Ctrl+v on the keyboard.
6. The formula will be copied to all
selected cells. It will calculate the
total for each student.
Figure 3.20: Paste formula
Ms Sharma is happy now. Spreadsheets have made
her work simple. Now, all she has to do is enter the
marks for all her students for each subject and the rest
will be done by the spreadsheet. And, if some of the
marks change, she does not have to do the calculations
all over again.

Need to format cells and content
Geeta makes very neat notes in her copy. She underlines
the headings and uses a black pen to write the
sub-topics. Sometimes, she writes important words in
capital letters to make them stand out. She even has a
neat rough work column on the side. Everybody wants
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her notes as they are easy to read and understand, and
the important points are clearly highlighted.
Electronic spreadsheets have many options to make
your content look neat and and easy to read. This is
called ‘formatting’. There are many ways in which you
can format the content in a spreadsheet. Let us work
with some of them.

Change text style and font size

Figure 3.21: Change font

Figure 3.22: New font and size

In case you want to give a different style
or a bigger size to the heading, you can
change the text style using the Font
drop-down as shown in Figure 3.21.
You can choose the style you like
from the drop-down. The text in all
selected cells will change.
Similarly, you can change the size
of the text from from the font-size
drop-down.
As you can see in Figure 3.22, the font
and size of the heading have changed.

Align (arrange) text in a cell
Sometimes, we see that text is placed in the centre of
the cell. How does this happen? In a spreadsheet, you
can position the text in a cell to the left, right or center.
This is the alignment feature of spreadsheet.
You can use the given icons on the
Tool Bar to align the text.
In Figure 3.23, the text in cell A1,
B1 and C1 has been aligned to the
centre. You can see that only the
selected cells have been aligned to
Figure 3.23: Align text
the center.

Highlight text
We make headings of our documents and tables
bigger and bolder than the rest of the text to make
them stand out. We also underline important words or
italicise them so that they, too, stand out. As shown in
Table 3.3, there are many ways in which we can highlight
the text in a spreadsheet.
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Table 3.3: Highlighting text
Action

Shortcut keys

To make text bold

Ctrl+b

To underline text

Ctrl+u

To make text italic
or slanting

Ctrl+i

Tool Bar icon

Practical Exercise
Run the e-learning lesson at http://www.psscive.ac.in/
Employability _Skills.html. This will include videos and e-content
for the above topics. Based upon the e-learning, do the
following activities.
Initial thinking activity
Why do you think we need to format content in a spreadsheet?
Practical group exercise
Run the e-learning lesson to get details on how to
run the activity.
Activity 1
Group practice
Formatting spreadsheets in LibreOffice Calc
Material required
Pen, computer with LibreOffice Calc installed, etc.
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Procedure
• Divide the class into groups, depending on the number of
computers. Choose a leader, who will direct the activity.
• The leader creates a table as shown in Figure 1. One
member center aligns the Roll No. and Name columns.
• Another member makes all column headings bold. Now,
some other member underlines the column headings.
Another member can increase the size of column B to
make the full name visible.

Figure 1: Activity 1 sample

Activity 2
Group practice
Basic calculations in LibreOffice Calc
Material required
Pen, paper, computer with LibreOffice Calc installed, etc.
Procedure
• Divide the class into groups, depending on the number of
computers available. Each group will select a leader.
• The leader opens a spreadsheet. As shown in Figure 1, each
member enters one’s roll number, name, marks obtained
in English, Hindi, maths and science, and calculates the
total marks in column G.
• Each member can use a different method to calculate the
total. Other members watch and give feedback on what
was done correctly and what could have been done better.
Your spreadsheet should look like the table given below.

Figure 1: Activity 2 sample
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Check Your Progress

Notes

A. Multiple choice questions
1. What is the default alignment of numbers in a cell?
(a) Left aligned
(b) Right aligned
(c) Center aligned
(d) Randomly aligned
2. “By default, the text in a cell is left aligned.”
State whether this is true or false.
(a) True
(b) False
3. What is the shortcut key to underline text in
a spreadsheet?
(a) Ctrl+b
(b) Ctrl+i
(c) Ctrl+l
(d) Ctrl+u
4. Which of the following features is used to
perform addition in spreadsheets?
(a) Format option
(b) Charts
(c) Graphs
(d) Formula
5. Which of the following signs define a formula?
(a) +
(b) /
(c) =
(d) +

What have you learnt?
After completing this Session, you will be able to:
•
•
•
•
•
•

add values directly in a spreadsheet.
add values using formulas.
add values using Sum() function.
align (arrange) text in a cell.
fit text into a cell.
highlight the text.

Session 4: Advanced Features
in Spreadsheet
Let us take an example of 500 students in a school.
Now, if the teacher wants to find the marks of a particular
student, for example ‘Seema’, she will have to look
through the entire list. It is a difficult process and may
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take a long time as the teacher has to go through all 500
names. Now, if she arranges the names alphabetically,
i.e., putting names starting with ‘A’ first, then names
with ‘B’, and so on, finding a name will be easier. One
knows that the name ‘Seema’, starting with the letter
‘S’, will come in the middle. This sorting or arrangement
of words in order can help one find a particular word or
name easily.

Sorting data
Let
us
take
another
example.
Ms Sharma has all her students’
subject marks and their totals in a
spreadsheet as shown in Figure 3.24.
If she wants to find out three students
with the highest marks, she will have
to search the entire list. This is even
more difficult if there are 100 or more,
students, for example, in the entire
batch or school.
Figure 3.24: Unsorted data
To make it easy, she can sort the data on the total
marks so that she knows the rank of the students in the
class. The steps to sort data are as follows.
1. Select all rows and columns that have to be sorted
as shown in Figure 3.25.
2. Click on Data, and then, select Sort as shown in
Figure 3.26.

Figure 3.26: Click on Data, and then, select Sort

Figure 3.25: Select data to be sorted
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3. This will give a Sort dialog box as
shown in Figure 3.27. Click on Sort
Key 1 and select total from the
drop-down. By default the order is
Ascending, which means from the
lowest to the highest. We will change
it to Descending. This will sort the
data in the total field.
4. Click on OK.
5. As shown in Figure 3.28, the data will
get rearranged in the entire list and the
name of the student with the highest
total marks will appear at the top,
and then, the student with the next
highest marks, and so on. Therefore,
the names of top three students will
appear in the beginning of the list
and the name of the student with the
lowest total marks will appear last.

Figure 3.27: Sort dialog box

Figure 3.28: Sorted data

Filtering data
Figure 3.29 has students from different
sections and Ms Sharma wants to see the
marks of students only from Class XII-A,
what will she do?
To do this, Ms Sharma can use another
feature of spreadsheet — ‘Filters’.
The steps to apply filter to a table are
as follows.
1. Click on the
AutoFilter icon on
the Tool Bar.
2. This will put filters at the top of each
column as shown in Figure 3.30.
3. Click on the filter for ‘class’ column.
4. The drop-down will show a list of all
the values in that column, for example,
Class XII-A and XII-B.
5. By default, all values are checked or
selected.
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Figure 3.29: Unfiltered data

Figure 3.30: Filters added
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6. If you want to see the data of students
only from Class XII-A, uncheck Class XII-B
as shown in Figure 3.31.
7. Click on OK.
8. Data of students only from Class XII-A will
be dispalyed as shown in Figure 3.32.

Figure 3.32: Filtered data

Figure 3.31: Selecting Class XII-A

Protecting spreadsheet with password
If Ms Sharma is sharing the computer with other
teachers and staff, she may want to protect her
data. She may not want anyone
else to open and make changes
to her work. She can do this
by protecting her spreadsheet
using a password. The steps
to protect a spreadsheet are
as follows.

Figure 3.33: Protecting spreadsheet

1. Click on Tools and select
Protect Spreadsheet as
shown in Figure 3.33.
2. A Protect Document dialog box
appears as shown in Figure 3.34.
3. Type in a password.
4. Type the same password in the
Confirm textbox.
5. Click on OK.

Figure 3.34: Protect Document dialog box

6. Now, when you close the file and open
it again, it will ask for the password.
Remember this password so that you can
open the file.
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Another way of protecting a spreadsheet is
as follows.
1. Click on File, and then, Save As.
2. A Save As dialog box will appear as shown in
Figure 3.35.

Figure 3.35: Save As dialog box

3. Type the file name and click Save with password.
4. Click on Save.
5. A Set Password dialog box appears as shown in
Figure 3.36.

Figure 3.36: Set password dialog box

6. Type a password in the first
textbox, and then, type the
same password in the
Confirm textbox.
7. Click on OK.
8. Now, when you try to open
the file, it will ask for a
password as shown in
Figure 3.37.
9. Type the password and
click on OK.
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Practical Exercise
Run the e-learning lesson at http://www.psscive.ac.in/
Employability _Skills.html. This will include videos and
e-content for the above topics. Based on the e-learning, do the
following activity.
Initial thinking activity
Why do you think we need to sort content in a spreadsheet?
Practical group exercise
Run the e-learning lesson to get details on how to
run the activity.
Activity 1
Group practice
Sorting data in LibreOffice Calc
Material required
Pen or pencil, computer with LibreOffice Calc, etc.
Procedure
• Divide the class into groups, depending on the number of
computers. Choose a leader, who will direct the activity.
• Open a new workbook. Enter your monthly expenses as
shown in Figure 1. Sort the data in alphabetical order.
Filter data to show expenses above `100.

Figure 1: Activity 1 sample

Check Your Progress
A. Multiple choice questions
1.

Which menu option will you use to sort data?
(a) Tools
(b) Data
(c) Format
(d) View
2. Mr Gupta has a spreadsheet with a list of 500 items in
his shop. A customer comes and asks for a particular
item. How should he arrange the data so that he can
find that item fast? What would Mr Gupta do? He will:
(a) apply filter.
(b) sort the data.
(c) use password.
(d) format data.
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3.

Mr Verma shares the computer in his office with other
colleagues. He wants to make sure no one sees the
financial data he saves on the computer. What should
he do?
(a) Lock the computer in a cupboard
(b) Change the password of his computer so
that no one can use it
(c) Apply password to the financial data sheet
(d) Leave it as it is and hope that no one will open it

Notes

What have you learnt?
After completing this Session, you will be able to:
• sort data.
• add filters.
• protect spreadsheet with a password.

Session 5: Presentation Software
Ms Sharma wants to explain water cycle to her
students. Mr Chaudhary wants to explain the
working of a product to his clients and Dr Suman
wants to give a lecture on her new research. All these
people need to make an impact on their audience.
They can use handmade charts or printed slides or
make a digital presentation using a computer and
presentation software.
Presentation software is being widely used to make
digital presentations. It has many advantages, which
are as follows.
1. They are interesting as they have features like
images, videos, animation and music.
2. Making changes in digital presentations is easy.
3. A digital presentation can be shown to a much
larger audience by projecting on a screen.
4. The presentation can be printed and distributed
to the audience.

Presentation software available
There are a number of presentation software available,
such as
1. LibreOffice Impress
2. Microsoft Office – PowerPoint
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3. OpenOffice Impress
4. Google Slides
5. Apple Keynote
Most features in all these software are same. We
will be discussing and using LibreOffice Impress to
create presentations in this Session as it is a free and
open software.

Steps to start LibreOffice Impress
1. First, you must ensure that LibreOffice Impress
is installed on your computer.
2. Type ‘LibreOffice Impress’ in the search bar
of Windows.
3. Select LibreOffice Impress from the search
results as shown in Figure 3.38(a).
4. LibreOffice Impress will open. Cancel the
‘Select a template’ dialog box.
5. A blank presentation will open [Figure 3.38(b)].

Figure 3.38(a): Select LibreOffice
Impress from the search results

Figure 3.38(b): Open LibreOffice Impress

Adding text to a presentation
By default, there are two textboxes in the first slide.
The top one is for the title and the lower (bigger) one for
other details. We can click on the title box and type in
a title. Similarly, we can click on the lower box and type
in some details as given in Figure 3.39.
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There are three main steps in water cycle.

Figure 3.39: Adding text to a slide

In this way, we can start using LibreOffice Impress
to make a presentation.

Practical Exercise
Run the e-learning lesson at http://www.psscive.ac.in/
Employability_Skills.html. This will include videos and
e-content for the above topics. Based upon the e-learning,
do the following activity.
Initial thinking activity
How do you make your projects?
Practical group exercise
Run the e-learning lesson to get details on how to run
the activity.
Activity 1
Group practice
Creating presentation in LibreOffice Impress
Material required
Pen, notebook, computer with LibreOffice Impress, etc.
Procedure
• Divide the class into groups, depending on the number
of computers.
• Choose a leader, who will direct the activity.
• Start LibreOffice Impress and create a new presentation
with the title ‘Advantages of using the Internet’.

Check Your Progress
A. Multiple choice questions
1. You have a summer vacation project on how to make
biogas. You have done a lot of research, clicked pictures
of biogas plants and taken videos of people, who use
biogas. Now, you have to make a presentation before
the class. What would you use?
(a) Chart paper
(b) Word document
(c) Presentation software
(d) Spreadsheet
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2.

What do you need to install on your computer to be able
to run Impress?
(a) Google
(b) Microsoft Office
(c) LibreOffice
(d) Apple iOS
3. How many textboxes does the first slide of LibreOffice
Impress have by default?
(a) 1
(b) 2
(c) 3
(d) 4

What have you learnt?
After completing this Session, you will be able to:
•
•
•
•

describe the advantages of digital presentation.
list various presentation software.
list features of a presentation.
create a new presentation.

Session 6: Opening, Closing, Saving
and Printing a Presentation
In this Session, we will learn about opening, closing,
saving and printing a presentation.

Steps to save a presentation
A digital presentation can be saved as a file on the
computer. This can be opened later, viewed, edited,
shared with friends and colleagues, and printed. It
is important to save the presentation several times
while working so that you do not lose data in case the
computer shuts down or there is a power cut.

Figure 3.40: ‘Save As’ dialog box

The steps to save a presentation for
the first time are as follows.
1. Click on File.
2. Select Save As or Save from
the drop-down. This displays a
Save As dialog box as shown in
Figure 3.40.
3. You can select a folder where
you want to save the file, for
example Desktop.
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4. By default, the File name is ‘Untitled#’ (# is
a number). You can change it to the name of
your choice.
5. The default Save As type is .ods. You can select
other file types from the Save As type drop-down.
You can save the file as MS Excel or HTML or
text file.
6. Click on Save.
This will save the presentation on the computer.
Later while working, you can simply click File>Save or
press Ctrl+s on the keyboard to save the presentation.

Steps to close a presentation
The steps to close a presentation are as follows.
1. Click on File.
2. Select Close from the drop-down.
3. If you have not saved the
changes before closing the file,
it will prompt you with a ‘Save
Document?’ dialog box as
shown in Figure 3.41. You can
decide whether you want to save
or not or cancel.

Figure 3.41: Save Document dialog box

Steps to open a presentation
The steps to open a presentation are
as follows.
1. Open LibreOffice Impress.
2. Click on File.
3. Then, select Open from the
drop-down.
4. This will display the Open dialog
box as shown in Figure 3.42.
5. Browse and select the folder
where your file is saved, for
example Desktop.

Figure 3.42: Open dialog box

6. Then, select the file, for example Water Cycle.
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7. Click on Open.
8. This will open the ‘Water Cycle.ods’ in
LibreOffice Impress.

Steps to print a presentation
Before you try to print a file, please make sure that a
printer is connected to the computer. The steps to print
a presentation are as follows.
1. Click on File.
2. Select Print from the drop-down or you can press
Ctrl+p on the keyboard.
3. A Print dialog box is displayed.
4. A printer attached to the computer is displayed
in the dialog box.
5. Select the number of copies you want to print.
6. Select All, if you want to print all slides.
7. Select Slides, if you want to print few of them and
provide the slide numbers.
8. Click on OK.

Practical Exercise
Run the e-learning lesson at http://www.psscive.ac.in/
Employability_Skills.html. This will include videos and
e-content for the above topics. Based on the e-learning, do the
following activity.
Practical group exercise
Run the e-learning lesson to get details on how to run the activity.
Activity 1
Group practice
Working on a presentation in LibreOffice impress.
Material required
Computer with LibreOffice Impress, pen, notebook, etc.
Procedure
• Divide the class into groups, depending on the number of
computers. Each group will perform the following activities.
– Save a presentation file by the name ‘Water Cycle Project’
– Close the file
– Open the file again
– Print the presentation
• Make sure that each student in the group gets a chance
to perform at least one activity. Other members can watch
and give feedback on what was done correctly and what
could be improved upon.
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Check Your Progress

Notes

A. Multiple choice questions
1. Which is the correct step to save a presentation?
(a) File>Save As>Type file name>Save
(b) File>Open>File name>Open
(c) File>Template>Save as Template
(d) File>Close>Save>OK
2. Which is the correct step to close a presentation?
(a) File>Save As>Type file name>Save
(b) File>Exit
(c) File>Close
(d) File>Export
3. Which is the correct step for printing a presentation?
(a) File>Print
(b) File>Print>Handout
(c) File>Print>Handout>OK
(d) File>OK

What have you learnt?
After completing this Session, you will be able to:
•
•
•
•

save a presentation.
close a presentation.
open a presentation.
print presentation slides.

Session 7: Working with Slides
and Text in a Presentation
Let us assume you have to make a presentation about
a product in your office. The time assigned for the same
is five minutes. If you highlight the important points
in the presentation, you can easily depict important
information in a short span. Let us look at how we can
make our presentation more effective.

Adding slide to a presentation
Ms Sharma listed all three steps of Water Cycle in the
first slide. Now, she wants to explain each step. But
it is not a good idea to put more information on one
page. This will make the text jumbled, and difficult
to read and understand.
Ms Sharma can add a new slide. Slides are like new
pages, which are added to separate different topics in
a presentation. Ms Sharma can add one slide each for
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evaporation, condensation and precipitation, and give
more details related to each topic in three different
slides. To add a new slide, do the following.
1. Click on Slide.
2. Select New Slide from the
drop-down as shown in Figure 3.43.
3. You can also press Ctrl+M on
the keyboard.
Figure 3.43: Adding a New Slide

4. This will add a blank New Slide to
the presentation.
5. The layout or arrangement of
textboxes, etc., will be similar to
the previous one.

Deleting slides
The steps to delete a slide are as follows.
1. Select the slide that you want
to delete.
2. Click on Slide.
3. Select Delete Slide from the
drop-down as shown in Figure 3.44.
4. The selected slide will be deleted.

Figure 3.44: Delete Slide

5. You can press ‘Del’ key on the keyboard to delete
the selected slide.

Adding and formatting text
The default layout of a LibreOffice Impress slide has two
textboxes — one for the title and other for text. You can
add text by simply typing on the keyboard.
If you have a blank slide with no textbox, you can
insert a textbox using the option Insert>Textbox as
shown in Figure 3.45. You can make this textbox of any
size, and then, enter the text.

Figure 3.45: Formatting text
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You can format the text in a presentation to make it
look better or attractive.
There are many font styles available to change the
way a text appears. Click on the Font Style drop-down
to select a different style. This will change the way the
text is written (Figure 3.45).
You can also change the size of the text by clicking
on the Font Size drop-down and select the size
(for example, 8, 12, 14, 22, etc.). The font size of the title
is increased to make it stand out.

Notes

Highlighting text — bold, underline, italic
To highlight a text in LibreOffice, you can make it bold,
underlined or italic, depending on the requirement.
First, select the text that has to be highlighted.
Then, hover over the given icons in the Properties tab
as shown in Figure 3.46. Select the icon required to
perform the desired function, i.e., making it bold, italic,
underlined or strikethrough.

Figure 3.46: Highlighting text

Aligning text — left, right, center, justified
The text can be aligned either left, right, center or
justified. Using the Paragraph option in the Properties
tab as shown in Figure 3.47, the text can be aligned.

Figure 3.47: Aligning text

‘Left or right aligned’ means that text will be aligned
to the left or right margin, respectively. ‘Center’ aligns
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the text to the center of the page. ‘Justify’ aligns the text
to the right and left margins.

Changing text colour
You can make the presentation even more interesting
by giving different colours to the text.
The Font Color drop-down gives various colours from
which you can choose and change the colour of the text
as shown in Figure 3.48. Besides the Font Color
drop-down, there is a Highlight Color drop-down. If you
select a colour from the Highlight Color drop-down, it will
change the background colour of the text.

Figure 3.48: Changing text colour

In this way, you can make the presentation
interesting and meaningful.

Practical Exercise
Run the e-learning lesson at http://www.psscive.ac.in/
Employability_Skills.html. This will include videos and
e-content for the above topics. Based on the e-learning, do the
following activity.
Practical group exercise
Run the e-learning lesson to get details on how to run the activity.
Activity 1
Group practice
Working with font styles, types in LibreOffice Impress
Material required
Computer with LibreOffice Impress, notebook, pen, etc.
Procedure
• Divide the class into groups, depending on the number of
computers. Each group will perform the following activities.
1. Insert a new slide.
2. Type ‘LibreOffice Impress’.
3. Change the font to ‘Open Sans’.
4. Colour the text white.
5. Colour the background green.
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6. The text should appear as given in Figure 1.
7. Now, type ‘Google’.

Notes

Figure 1: Activity 1 sample 1

8. Change the font to ‘Bookman Old Style’.
9. Change the size to 54.
10. Colour the letters as given in the Figure 2.

Figure 2: Activity 1 sample 2

Make sure each student in the group gets a chance to perform
this activity. Other members can watch and give feedback on
what was done correctly and what could be improved upon.

Check Your Progress
A. Multiple choice questions
1. Which menu option do you use to insert a slide?
(a) Edit
(b) Insert
(c) Slide
(d) Tools
2. How will you, usually, align the title of a slide?
(a) Left
(b) Right
(c) Center
(d) Justify
3. Which option will you use to change the colour
of the text?
(a) Font Color
(b) Font
(c) Highlight Color
(d) Format
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What have you learnt?
After completing this Session, you will be able to:
•
•
•
•

add a slide to a presentation.
delete a slide in a presentation.
enter and edit text in a presentation.
format text in a presentation.

Session 8: Advanced Features
used in Presentation
There are various advanced features used in a digital
presentation. The use of graphics, charts and images
can make the presentation more meaningful.

Inserting shapes in
presentation

Figure 3.49: Inserting shape in a slide

Figure 3.50: Using Properties tab

You may want to use
arrows to show the
flow of a process in
a presentation. For
example, if you want to
show how Water Cycle
works — you can use
arrows. LibreOffice
provides numerous
shapes, such as lines,
square, circle, arrows,
symbols, etc., that can be
inserted into slides.

As shown in Figure 3.49, to insert an arrow, you
must click on Insert, and then, select Shape. This
has several options. Choose Arrow to see different
types of arrow. Select the one required for the
presentation, for example, ‘Circular Arrow’. In this
way, you can select any shape you want.
Once a shape is inserted in a slide, you can use
the Properties tab to make changes to the properties
of the shape, such as colour, size, position,
direction, etc.
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Inserting clipart and images in presentation
A picture speaks a thousand words. We use a lot of images
in a presentation to make it simple and interesting. The
steps to insert a clipart or an image are as follows.
1. Click on Insert from the menu.
2. Select Image as shown in
Figure 3.51.
3. An Insert Image dialog box
appears as shown in
Figure 3.52.
4. Browse through folders and
select the image you want to use.

Figure 3.51: Select Image

Figure 3.52: Insert Image dialog box

5. Click on Open.
In this way, you can insert images in your presentation
slides and make it more interesting.

Figure 3.53: Images inserted in a slide
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Changing slide layout
The default layout of a LibreOffice Impress slide contains
one textbox for the title and one for content. Layout
helps to arrange the slide content in an
organised way. However, you can change
the slide layout as per the requirement.
In case, you want to insert an image of
water cycle on one side and give the steps
on the other, you can select a layout with
one title and two boxes. You can do this
by simply selecting the slide, and then,
selecting the desired layout from the
Layouts tab as shown in Figure 3.54.
Having a layout helps to align the content
Figure 3.54: Selecting the desired layout
from the Layouts tab
in the desired way.

Practical Exercise
Run the e-learning lesson at http://www.psscive.ac.in/
Employability_Skills.html. This will include videos and
e-content for the above topics. Based upon the e-learning, do the
following activity.
Practical group exercise
Run the e-learning lesson to get details on how to run the activity.
Activity 1
Group practice
Working with slides in LibreOffice Impress
Time: 20 minutes
Material required
Computer with LibreOffice Impress, notebook, pen, etc.
Procedure
• Divide the class into groups, depending on the number of
computers. Each group will perform the following tasks.
– Set the layout of the slide to Title
and four content.
– Insert two different shapes on
the left, for example, star
and diamond
– Insert an image of star and
diamond on the right.
– Your slide should appear similar
Figure 1: Activity 1
to the one given in Figure 1.
sample
Make sure that each student in the group
gets a chance to perform at least one task. Other members can
watch and give feedback on what was done correctly and what
could be improved upon.
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Check Your Progress

Notes

A. Multiple choice questions
1. Which menu option will you click on to insert shapes
and images?
(a) Format
(b) Tools
(c) Edit
(d) Insert
2. What are the steps to insert a square shape in
a presentation?
(a) Insert > Shape> Line> Square
(b) Tools > Shape> Line> Square
(c) Insert > Shape> Basic > Square
(d) Format > Text > Basic> Square
3. What happens when you change the layout of a slide?
(a) The format of the text changes
(b) New slide is inserted
(c) The arrangement of content (text, images, shapes)
changes
(d) The title gets aligned to the center of the slide

What have you learnt?
After completing this Session, you will be able to:
• insert shapes.
• insert clipart and images.
• change slide layout.

Further Readings
• https://edu.gcfglobal.org/en/powerpoint2016/insertingpictures/1/
• https://www.gcflearnfree.org/excel2016/getting-startedwith-excel/1/
• https://www.webucator.com/tutorial/learn-microsoftexcel/entering-data-microsoft-excel-worksheets.cfm
• https://www.gcflearnfree.org/excel2013/formattingcells/1/
• https://www.youtube.com/watch?v=sJqfvgD_qMI
• https://edu.gcfglobal.org/en/excel2013/filtering-data/1/
• https://edu.gcfglobal.org/en/powerpoint2016/creatingand-opening-presentations/1/
• https://edu.gcfglobal.org/en/powerpoint2007/viewingand-printing-slides/1/
• https://edu.gcfglobal.org/en/powerpointxp/formattingtext/1/
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Unit

4

Entrepreneurship
Skills
Introduction
Entrepreneurs identify an innovation to seize an
opportunity, mobilise funds, raise capitals and take
calculated risks to open market or new business for
products, processes and services.
Entrepreneurship development refers to the process
of enhancing entrepreneurial skills and knowledge
through structured training and institution building
programmes. It focusses on an individual, who wishes
to start or expand a business. Promising entrepreneurs
need to be nurtured and helped to serve as role models
and mentors for their communities. An entrepreneurship
development programme must be designed in a way so
as to help aspiring entrepreneurs recognise and design
unique and innovative business opportunities based on
an analysis of local conditions and their own skills.
Business opportunity surveys may provide advice
to entrepreneurs but they must be analysed in the
context of specific market situation in each case. To
determine the market potential, it is useful to conduct
need assessment or demand survey before programme
formulation. Motivational intervention may be needed
for initiating growth and development of an enterprise.
Training in entrepreneurship development needs to
include support for — (a) entrepreneurship orientation
and awareness, (b) development of competencies

(knowledge, skills and attitudes) necessary to recognise
a market opportunity and organise resources to meet it,
and (c) improvement of business performance for growth
and competitiveness. Motivation, besides increasing
need for achievement of potential entrepreneurs, also
helps them develop coping ability, tolerance to ambiguity
and influencing capability.
The National Institute for Entrepreneurship and Small
Business Development is a premier organisation of the
Ministry of Skill Development and Entrepreneurship,
Government of India, engaged in training, consultancy
and research to promote entrepreneurship and skill
development. The major activities of the Institute
include training of trainers, management development
programmes, entrepreneurship-cum-skill development
programmes, entrepreneurship development programmes
and cluster intervention.

Notes

Session 1: Entrepreneurship
and Entrepreneur
The word ‘entrepreneur’ is derived from the French word
entreprendre, which means ‘to undertake’. Cole defines
entrepreneurship as, “A purposeful activity to initiate,
maintain and aggrandise profit-oriented business.”
Stevenson and Jarillo define entrepreneurship as:
“The process by which individuals pursue opportunities
without regard to the resources they currently control.”
Entrepreneurship can, thus, be defined, as “an economic
process, where an idea is generated or an opportunity
is created, refined, developed and implemented, while
being exposed to uncertainty to realise a profit by
effective utilisation of resources”.
Economists define an entrepreneur as someone, who
brings in resources, labour, material and other assets
into profit making combinations.
Psychologists define an entrepreneur as a person,
who is, typically, driven by a psychological force, which
creates a desire to obtain or attain something.
Sociologists define an entrepreneur as a person,
whose actions would determine social status and
contribute to societal development.
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Management gurus define an entrepreneur as a
person, who has a vision and generates an action plan to
achieve it.

Characteristics of entrepreneurship
On the basis of the above mentioned definitions,
the following are some of the characteristics of
entrepreneurship.
• It is an economic activity done to create, develop
and maintain a profit-oriented organisation.
•

It begins with identifying an opportunity as a
potential to sell and make profit in the market.

•

It deals with optimisation in utilisation
of resources.

•

It is the ability of an enterprise and an
entrepreneur to take risks.

Entrepreneurship — art and science
Entrepreneurship is considered to be both an art and
a science. For a subject to be considered as science, it
needs to have a stepwise progression substantiated by
valid proof like chemistry or physics. There are steps
that need to be followed to attain a specific result. On
the other hand, some subjects are categorised as art,
where no specific way to attain a result is required
and the skill of using the subject matter is of prime
importance. An example of art is music. A musician can
play music notes in any combination to create soothing
and soulful music. Entrepreneurship is the perfect
combination of art and science as it requires specific
progression and procedures to be followed and also the
skill to digress when required, and yet make the entire
activity profitable and growth oriented.
An entrepreneur is someone, who has the capability
to start an organisation by organising various
resources required to make an opportunity purposeful.
Entrepreneurs are not necessarily motivated by
profit but may regard it as a standard for measuring
achievement or success.
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Qualities of a successful entrepreneur

Notes

Let us now consider the qualities that make an
entrepreneur successful. There may be many qualities
needed to successfully run an enterprise. However, the
following qualities are considered important.
(a) Initiative: In the world of business, opportunities
come and go. An entrepreneur must be able to
initiate action and take advantage of an opportunity.
Once a person misses out on an opportunity, it
may not come again. Therefore, taking initiative
on the part of the entrepreneur is a must.
(b) Willingness to take risks: In any business,
there is an element of risk involved. It implies
that it is not necessary that every business
shall earn a profit. This deters individuals to
take up risks and start a business. However, an
entrepreneur always volunteers to take risks to
run a business and be successful.
(c) Ability to learn from experience: An entrepreneur
may make mistakes. However, once an error
is committed, it must be tried that it is not
repeated as it may lead to heavy losses. Therefore,
the person must have the ability to learn
from experience.
(d) Motivation: It is necessary for success in
every walk of life. Once you get motivated to do
something, you will not rest until you complete
it. For example, sometimes, you become
so intrested in reading a story or magazine
that you do not sleep until you complete it.
This kind of interest in work comes through
motivation. It is an essential quality to become a
successful entrepreneur.
(e) Self-confidence: For achieving success in
life, a person needs to have confidence in
oneself. Someone, who lacks confidence, may
not be able to achieve much in life or inspire
others to work. Self-confidence is reflected
in courage, enthusiasm and ability to lead.
Therefore, a successful entrepreneur must have
self-confidence.
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(f) Hard work: There is no substitute for hard
work in life. While running a business, one
problem or the other may arise every day. The
entrepreneur has to be vigilant so as to identify
the problems and solve them as early as
possible. This requires hard work on the part
of the entrepreneur. The person cannot afford
to say: “The office hours are over now and I will
not work any longer.” In some situations, the
person may even have to work for the whole
night. Thus, hard work is the secret of success
for an entrepreneur.
(g) Decision making ability: In running an
enterprise, an entrepreneur has to take a number
of decisions. Therefore, the person must be
capable of making suitable and timely decisions.
In the present world, things move very fast. If an
entrepreneur does not have the ability to make
suitable and timely decisions, the person may
miss out on an opportunity and incur losses.

Type of entrepreneurs
There are many type of entrepreneurs, which include
the following.

Service entrepreneurs
These entrepreneurs either create a new market for
their services or provide a service in an existing market.
They spot an idea and convert it into a service, which
is unprecedented or not available in the market. It is
irrespective of the nature and size of operations but is
essentially a service.

Business entrepreneurs
These are entrepreneurs, who undertake business
and trading activities and are not concerned with the
manufacturing work. A business entrepreneur identifies
the potential of a product in a market. From that point
onwards, the business and trading entrepreneur is
responsible for stimulating demand for the product.
The product may be existent in a foreign market but
the person is able to stimulate demand for the same in
local market.
82

Employability Skills – Class XII

Industrial entrepreneurs

Notes

An industrial entrepreneur is, essentially, a manufacturer,
who identifies the needs of customers and creates products
or services to serve them. Such an entrepreneur is product
oriented, who starts through an industrial unit to create a
product like electronic industry, textile unit, machine tools,
manufacturing unit, etc.

Agricultural entrepreneurs
Agriculture has always been considered as a low‑yielding
entrepreneurship. Agriculturists have now introduced
new and innovative technology to maximise the yield,
giving birth to agriculture entrepreneurship.

Technical entrepreneurs
The Industrial Revolution gave birth to technical
entrepreneurs, who use their technical expertise to
create and offer machines, tools and methods. They
constantly innovate to make industrial processes
seamless and efficient. Technical entrepreneurs use
their technical knowledge and skills to innovate.

Non-technical entrepreneurs
These entrepreneurs use their expertise in providing
services to create a market for technical entrepreneurs.
Their expertise is in non-technical aspects of a product
or service, i.e., they are not concerned with the
manufacturing process but have more to do with before
and after the manufacturing process.

Professional entrepreneurs
Such an entrepreneur starts a business, nurtures it
and makes it reach a point of self-sustenance. Once the
project reaches that point, the entrepreneur sells the
business and starts a new one, and then, follows the
same cycle.

IT entrepreneurs
People who take up entrepreneurship in the field of
Information Technology (IT) are called IT entrepreneurs.
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The difference between IT entrepreneurs and technical
entrepreneurs is that the latter work in the field
of electronics, mechanical devices or even civil
works, while IT entrepreneurs are confined to innovation
in the field of Information Technology.

Women entrepreneurs
As the name suggests, when women take up
entrepreneurship, they are called women entrepreneurs.
A number of women entrepreneurs are taking initiatives
in starting entrepreneurial activities and many of them
have even made it to the top.

Social entrepreneurs
Individuals, who focus on developing solutions that
benefit the society, are called social entrepreneurs.
They develop, fund and implement solutions that are
directed towards society, culture and environment. The
term ‘social innovator’ is used interchangeably with
social entrepreneurs.

Family business entrepreneurs
When a family or an individual runs a business
successfully and passes it on to the next generation,
then such an entrepreneur is, generally, termed as
family business entrepreneur. The person, who is
handed over the business or the functioning of an
enterprise, is not the first generation entrepreneur. The
person carries out all entrepreneurial activities as
inherited in the same manner or introduces certain
technological advancements to the existing way and
method of the family business.

First generation entrepreneurs
First generation entrepreneurs are
those who do not have any
entrepreneurship background. They
can be of different age groups and
backgrounds. An individual, who
starts at the age of 50 years without
any entrepreneurship background, is
also a first generation entrepreneur
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and someone else, who starts at the age of 17 years, is
also a first generation entrepreneur.

Notes

Roles and functions of an entrepreneur
Some of the major functions performed by an
entrepreneur are as follows.
(a) Identifying entrepreneurial opportunity: There
are many opportunities in the world of business.
These are based on human needs like food,
fashion, education, etc., which are constantly
changing. These opportunities are not realised
by the general public. But an entrepreneur
senses the opportunities faster than others. The
entrepreneur, therefore, has to keep one’s eyes
and ears open at all times. A person, who wants
to become an entrepreneur, requires imagination,
creativity and innovativeness.
(b) Turning ideas into action: Entrepreneurs must
be capable of turning ideas into reality. They
should be able to collect information regarding
ideas, products and practices to meet the
market demand.
(c) Feasibility study: Entrepreneurs conduct studies
to assess the market feasibility of a proposed
product or service. They anticipate problems
and assess quantity, quality, cost and sources
of inputs required to run the enterprise. Such a
blueprint of all activities is termed as a ‘business
plan’ or ‘project report’.
(d) Resourcing: An entrepreneur needs various
resources in terms of money, machine, raw
material and workforce to run an enterprise
successfully. An essential function of an
entrepreneur is to ensure the timely availability
of all these resources.
(e) Setting up an enterprise: For setting up an
enterprise, the entrepreneur may need to fulfil
some legal formalities. The person must also try to
find a suitable location, design the premises, install
machinery and do many other works.
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(f) Managing the enterprise: One of the important
functions of an entrepreneur is to run the
enterprise. The person has to manage the
workforce, material, finance and organise the
production of goods and services. The person
has to market each product and service, after
ensuring appropriate returns (profits) of the
investment. Only a well‑managed organisation
yields the desired results.
(g) Growth and development: Once the enterprise
achieves the desired results, the entrepreneur
has to explore another higher goal for its growth
and development. The person is not satisfied only
with achieving a set goal but constantly strives
for achieving excellence.

What motivates an entrepreneur?
Every human has a nature to create and pro-create,
and to dream and work to fulfill those dreams. But not
every human is able to handle failures. An entrepreneur,
on the other hand, has the potential and willingness
to overcome every hurdle that comes in way of the
person’s entrepreneurial endeavours. The person finds
out ways and means to pursue one’s dreams and fulfil
the goals.
Following are some of the qualities that motivate
an entrepreneur.

Standard of excellence
An entrepreneur constantly sets
high standards and strives to
attain the standard of excellence
by working hard and showing
innovativeness.

Uniqueness
For an entrepreneur, one of the
most important qualities is to
remain unique in everything the
person does and the way it is done.
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Focus on long-term goals
Long-term goals are those that are distant in terms of
time period. An entrepreneur focusses more on what
is to be achieved in distant future rather than in near
future. The person will plan and work patiently to
achieve the long-term goals.

Need to influence
The entrepreneur perceives one’s ideas as revolutionary
and expects them to influence the world in a substantial
way. For most entrepreneurs, their ideas have impacted
the world and some have completely changed the look
of the world.
A wage employed person is someone, who works
for an individual or organisation and gets paid for the
same. An entrepreneur is a self-employed person, who
strives to make the business better by taking risks and
trying new ideas.
Entrepreneurship is the act of setting up and running
a business, and taking risks in order to earn profits.
Nutan always had a passion for cooking. As a child,
she had an accident and became wheelchair bound. It
was a difficult situation. But it did not stop her from
pursuing her dreams. Nutan got an internship in
her neighbour’s restaurant and learnt to work in the
kitchen. Two years after working there, she decided to
start a dabba (tiffin) service. She would prepare and
send lunch to 100 people in an office building nearby.
Eventually, she introduced a menu from where people
could choose what food they wanted to have instead of
everyone getting the same food. Here are some things
you would have learnt from Nutan’s story.
1. When she was working in her neighbour’s
restaurant, she was a wage employed person
because she was working for someone.
2. She set up her food business. She was an
entrepreneur as she was taking a risk by trying
new ideas and introducing a menu.
3. Where there is a will, there is a way! We can do
anything, if we decide.
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Identifying opportunities and risk taking
A key question faced by budding entrepreneurs is finding
the business opportunity that is right for them. Should
the new venture focus on a new product or service?
Should the venture select an existing product or service
from one market and offer it in another, where it may
not be available?
Some ways by which aspiring entrepreneurs can
identify new business opportunities and evaluate their
potential and risks are as follows.
• Community concerns: Look for issues that
concern your community. Sometimes, starting
locally can reap huge benefits. Identify the
inefficiencies, analyse how an idea can help and
evaluate the risks involved.
• Personal experiences: Many powerful world
changing ideas come from the experiences and
challenges an entrepreneur faces in life. If you
aspire to become an entrepreneur, you must
listen to the personal stories of successful
entrepreneurs and draw inspiration. Their
experiences may teach you powerful lessons
in entrepreneurship and give an insight into
some business strategies that you may adopt to
become successful.
• Research with others: Speak to like-minded
people, get involved through social groups and
join local startup groups. Many a time, discussion
with others opens various doors of opportunities.
It also helps to learn the nuances of business.
For an entrepreneur, it is all about spotting the
right opportunity and taking the leap of faith. Mark
Zuckerberg thought about a simple idea of connecting
with his college friends through Internet. His simple
idea sparked the ‘social movement’, and today, almost
all of us are connected through ‘Facebook’.

Startups
A startup is a company that is in the first stage of
its operations. A startup and a traditional business

88

Employability Skills – Class XII

venture are different, most notably for the way they
think about growth. A startup is often financed by the
founders until the business gets off the ground, and it
gets outside finance or investments.
We hear a lot about startups being founded these
days. It can be in the field of technology, health care,
food, virtual reality, etc. Let us understand more
about startups.
• Startups can be started with
minimum investment. Most
startups thrive on an idea that
involve technology or offer
technology‑driven solutions.
For example, a lot of startups
have started online food delivery. With the help
of a robust app, they partner with food service
providers or restaurants, and help in the home
delivery of food.
•

Startups seek financial investment differently
than most small businesses. They rely on
capital that comes via angel investors or
venture capital firms, while small business
operations rely on loans and grants. A lot of
Indian startups, too, have received funding
from global investors.

•

Startups come up with an innovative idea. At
the same time, they like to get guidance and
mentoring from an expert. Most people, who create
startups, join various groups at local and global
level for continued support by expert mentors and
investors. ‘Startup India’, a flagship initiative of
the Government of India, is intended to build an
ecosystem for the growth of startup business.
Startup policies have been formulated by the
States. Under this scheme, new startups in
India can avail regulatory and tax benefits,
capital gain exemption, as well as, access to
government funding, if they fulfil the criteria.
(Website: http://startupindia.in).
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Can you think of any
startup around you?
Have you read about any
startup in newspapers?
Discuss and list the
names of three startups.
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Practical Exercise
Activity 1
Group discussion
The topic for discussion is — ‘An entrepreneur is not born
but created’.
Material required
Notebook, pen, etc.
Procedure
• Divide the class into two groups.
• Each group brainstorms and states points — one for ‘an
entrepreneur is born’ and the other for ‘an entrepreneur
is created’.
Activity 2
Group practice
Entrepreneurship quiz
Material required
Notebook, pen, etc.
Procedure
In this activity, we will identify and differentiate between
entrepreneurs and wage employed people.
Instructions
1. Each row in the class shall be a group. Thus, we shall
have four groups in the class.
2. Each group shall assign one person to be the ‘buzzer’
person. You must have seen game shows, where the
person who wants to give an answer presses a button,
and a loud beep sound is produced. That is a buzzer. We
do not have a buzzer but we have benches! So, the ‘buzzer’
person from a group shall tap the bench if the person’s
group knows the answer.
3. The teacher will speak out aloud various professions.
Each group must guess if that person is an entrepreneur
or a wage employed person.
4. Discuss the difference between an entrepreneur and a
wage employed person with the group.
5. Here are the situations.
(a) Rama is a vegetable seller, who sells only organic
vegetables.
(b) Suresh runs a food delivery business that delivers
food between 12 noon and 5 am.
(c) Sahida is a manager in a software company.
(d) John is a school teacher in a village.
(e) Gurdeep has a yoga centre that conducts classes for
senior citizens.
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Check Your Progress
A. Multiple choice questions
1.

Salman tries new ideas as a tailor in a garment factory.
Salman is a/an ______________.
(a) entrepreneur
(b) wage employed person
(c) labourer
(d) unskilled worker
2. Prashant works for Surabhi, who is a businesswoman.
Prashant is an ___________________.
(a) entrepreneur
(b) wage employed person
(c) skilled worker
(d) businessman
3. Ridhi owns a construction company and takes risky
decisions in her work everyday. Ridhi is an ___________ .
(a) entrepreneur
(b) wage employed person
B. Short answer question
1. Name an entrepreneur you admire and what do you
admire about the person.

What have you learnt?
After completing this Session, you will be able to:
• explain the qualities of an entrepreneur.
• what is entrepreneurship.

Session 2: Barriers

to

Entrepreneurship

You must have watched a 100m hurdle race for women
or 110m hurdle race for men in school or stadium.
Some of them were obstacle races, in which there
would be hurdles — you would need to jump over to
get to the end line and if you ran fast enough, you
would win.
A business venture is a lot like hurdle race.
It, usually, involves risks. A risk is any situation,
which involves danger.
So, while running the race as an
entrepreneur, many hurdles, such as financial
constraints may come in way. These things
can stop the person from achieving success.
These are called ‘barriers’. One day while
going to school, a tree falls on road. It stops
Entrepreneurship Skills
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all vehicles. It is a barrier that is stopping you from
reaching school on time.
What do you think can be the barriers that
entrepreneurs may face while running their ventures?
Talk to some entrepreneurs in your area and find out.
After having spoken with the entrepreneurs, you would
have realised that they face a lot of barriers on their
path to success. Whether it is lack of knowledge or lack
of funding, there are various barriers that can prevent
one from pursuing one’s passion for entrepreneurship.
Here are some of the most common barriers.

Environmental barriers
One of the biggest barriers that entrepreneurs face is
environmental factors. Environmental factors can be
many. But the most common ones include the following.
• Lack of adequate resources or raw material
•

Non‑availability of skilled labour

•

Lack of requisite machinery and other
infrastructure

• Unavailability of monetary resources on time
These barriers can be easily overcome by studying
the market well enough before taking a decision about
the venture. Research, market surveys and mentor
guidance can help overcome such barriers.
The Indian Government has come up with various
schemes to help small‑scale entrepreneurs gain capital.
Some of these are:
• Government Mudra Yojana — https://
mudralsans.in/
•

Credit Guarantee Scheme — https://www.cgtmse.in/

•

Stand‑Up India Scheme — https://www.
standupmitra.in/

No or faulty business plan
“A goal without a plan is just a wish.”
Every entrepreneur wants a successful business. But
if a person does not make an action plan, it may lead
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to a chaotic situation. Having a plan to reach the goal
helps the person in knowing one’s role in running a
successful business and pushes everyone associated
with it to work harder.

Personal barriers
How long will the business last? How much profit will
it make? Will my customers like my product? Will I
have enough money to support my family? These are
the questions that might go through an entrepreneur’s
mind before the person actually starts a business
venture. Establishing any new venture is a risk because
there is always a fear of what may go wrong. Secondly,
finding a suitable team is also a tedious job. A team of
careless and non-suitable workers may cause damage
to a business.

Self-doubt
It is easy to get discouraged when something goes
wrong in a business. One starts doubting oneself and
may even feel like giving up. Self-doubt comes when we
do not have confidence in ourselves and our abilities.
One of the best ways to deal with self-doubt is to
work towards one’s goals. When we lack motivation,
just looking at our goals and knowing that the tasks
we are doing today are contributing to our long‑term
goals help us feel better. Having family and friends, who
know our goals and support us when we are doubting
ourselves, also help.
We are all scared of failing. We put in a lot of effort
into our idea and give it our best to make it happen.
Believing in ourselves is the first step towards crushing
the fear of failure.

Forming a team and teamwork
Finding suitable people and training them to put in
their best for the business is a tedious and dificult
exercise. As an entrepreneur, one must find people,
who think and feel like the rest of the team. When new
people fit into the culture of the team, work can happen
better and faster.
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Practical Exercise
Activity 1
Entrepreneur interview
Material required
Notebook, pen, etc.
Procedure
In this activity, we will speak to an entrepreneur about the
problems the person faces in business.
Instructions
1. Find an entrepreneur in your area.
2. Ask questions, such as how the person got the idea of
starting the business and “what were the major difficulties
that the person faced.
3. Note down the answers in your notebook.
Activity 2
Fishbowl of fears
Material required
Notebook, pen, etc.
Procedure
In this activity, we will talk about what we fear about
entrepreneurship.
Instructions
1. We have learnt about the barriers that entrepreneurs
face. Now, each one of us shall think about what we fear
might be the biggest barrier for us when we start our
business venture.
2. Sit in a circle.
3. Take a chit of paper and write down what barrier might
stop you when you start a venture. Do not write your
name on the chit.
4. Put all chits in the centre of the circle.
5. Each person will pick up a chit and read someone’s fear.
Then, the class will spend two minutes, and try to find
out solutions for that person’s fear. If the person wants to
reveal one’s name at this point, one can do so.
6. It is difficult to talk about one’s fears in front of everyone.
So, all students must listen to each other and extend
support. They must not laugh when someone is sharing
one’s story.
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Check Your Progress

Notes

A. Match the situations in the columns to the
meaning of the word.
Situations

Word

(a) Gauri has started a fashion designing (i) Barrier
store, where she sells clothes.
(b) Akshay wants to start more classes in (ii) Risk
his school but is finding it difficult to
hire teachers.
(c) Shubham has a business of selling (iii) Venture
groceries. He wants to open a store that
sells everything from clothes to shoes to
bags, along with groceries.
B. Multiple choice questions
Identify and put a tick mark () against the type of barrier in
each situation.
1.

Mary believes that she will not have the ability to work
with a team when she starts her business. The barrier
she is facing is _____________________.
(a) getting capital
(b) self-doubt
(c) risk taking

2.

Sayed knows what business he wants to do but does
not know what steps he has to take to get it running.
The barrier stopping him is _____________________.
(a) building the right team
(b) lack of plan
(c) risk taking

3.

Harish has a rug business in India. He wants to start
exporting rugs to Canada but does not know if they
would sell there. The barrier he is facing is _____________.
(a) self‑doubt
(b) lack of plan
(c) selecting the right business idea

What have you learnt?
After completing this Session, you will be able to:
• identify barriers and fears related to becoming
an entrepreneur.
Entrepreneurship Skills
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Session 3: Entrepreneurial Attitudes
Entrepreneurs think and act differently from people
who are wage employed. But how are they different?
Let’s read Bitti’s story and understand.
Bitti is from the city of Bareilly in Uttar Pradesh.
She attends her cousin’s wedding but finds it very
boring because nobody is dancing. She starts talking
to people to find out the problem. Older uncles and
aunties tell her that other people would judge them
if they dance. Young people tell her that the DJ is
not playing the latest music. After attending five more
weddings, she realises that this is a problem that a
lot of people face at weddings. She sees a business
opportunity here.
Bitti, then, starts her wedding entertainment company.
The company has two parts — a dance academy and a
music business. The dance academy holds dance classes
for children in the morning and for people above the
age of 50 years in the evening. For the music business,
she hires young people in the age group of 16–30 years
to research on the latest popular music. At first, she
finds it hard because she has no prior experience of
running a business or working with a group of people
so different from each other. But that does not stop her
from putting in efforts into the business.
What did Bitti do or think differently from someone
else? Discuss with your partner and write it in
your notebook.
An attitude is a way of thinking or feeling about
something. It can be positive or negative, good
or bad. We shall learn about positive attitudes
of entrepreneurs.
The attitude an entrepreneur has is different from
that of a wage employed person. A wage employed person
has to do one’s job and not worry about the company.
But the entrepreneur thinks and acts differently. The
person not only thinks about one’s work but also about
the work of one’s employees and the work required for
the growth of the company.

96

Employability Skills – Class XII

After reading Bitti’s story, the attitudes that make a
successful entrepreneur are given in Figure 4.1.
DECISIVENESS
Ability to make quick and
profitable decisions

What it takes
to become an
entrepreneur?

TAKING INITIATIVE
Ability to take charge
and act in a situation
before others

ORGANISATIONAL
SKILLS
Ability to make the optimum use
of time, energy and resources to
achieve the desired goals

INTERPERSONAL
SKILLS
Ability to work
with others

PERSEVERANCE
Ability to continue to do
something, even when it
is difficult

Figure 4.1: Attitudes of an entrepreneur

Check Your Progress
A. Multiple choice questions
1.

The ability to continue to do something, even when it is
difficult is called _________________.
(a) initiative
(b) organisational skills
(c) perseverance
2. The ability to act in a situation before others do is
______________.
(a) interpersonal skills
(b) initiative
(c) perseverance
3. The ability to work with others is ______________.
(a) organisational skills
(b) interpersonal skills
(c) initiative
B. Short answer questions
1.

What do you understand by attitude?

2.

What do you understand by interpersonal skills? Share
an example where you displayed interpersonal skills.
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C. Match Bitti’s actions from the attitudes we have learnt
that an entrepreneur need to possess. Write them in the
table given below.
Attitudes an
entrepreneur need
to possess

Bitti’s actions

Decisiveness

She decides to start a dance
academy after seeing a need and
talking to people about it.

Initiative
Interpersonal skills
Perseverance
Organisational skills

What have you learnt?
After completing this Session, you will be able to:
• identify the attitudes that make an entrepreneur
successful.

Session 4: Entrepreneurial Competencies
In the previous Session, we learnt about the attitudes
that an entrepreneur need to possess to become
successful. Here, we shall learn about the competencies
required by a person to build entrepreneurial attitude.
Competency is the ability to do something well. Figure 4.2
shows the attitudes and competencies required to
become a successful entrepreneur.
Attitudes and competencies
INTERPERSONAL
SKILLS

PERSEVERANCE

Realise that you
can take action

Listening

Not giving up

Time
management

Identify
opportunities

Believe you can
take action

Positive body
language

Working hard

Goal setting

Analyse the
opportunity

Take action!

Positive attitude

Learning from
failures

Efficiency

DECISIVENESS

INITIATIVE

Know yourself

Problem solving

Stress
management

ORGANISATIONAL
SKILLS

Managing quality

Figure 4.2: Attitudes and competencies to become a successful entrepreneur

The journey to understand our competencies first starts
with understanding who we are. We grow and change
every single day. We understand what we like and what
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we do not. We make mistakes and learn from them. It is
important to stop and think about how we have changed
as people over the years.
Sometimes while thinking about our life, we might
judge ourselves too much. We do not like it when we
make mistakes and think that we cannot do something
because we have made a mistake. At those times, it is
important to remember to see ourselves from the point
of view of people around us. They may have positive
things to say about us.
Let us learn about the entrepreneurial attitudes
through different exercises.

Decisiveness
Decisiveness is the ability to make profitable and
quick decisions. How does a person become decisive as
an entrepreneur?
Decisiveness becomes the most important attribute
while setting up a business venture. It is about identifying
an opportunity and acting on it. An opportunity is a
chance to do something, generally, the right time or
moment to do something.
Decisiveness can be developed through the following
process as shown in Figure 4.3.
DECISIVENESS

Knowing yourself
You must know what is important for you —
What kind of problems do you want to solve?
What do you see around that bothers you?
What are you good at that can help you solve these problems?

Analyse the opportunity
The next step is to study your idea.
If it works, why would it work? What problems
could stop the idea from becomming successful?
What do the customers think about the idea?
What is the competition for that idea?

Identify opportunities
Figuring out the right moment and place where a
business will work is important.
Who are the people you want to help?
What problems do they have?
What ideas do you have to solve them?

Problem solving
After studying the customers and market, you
may make changes to your idea.
What would be the final idea? What makes it
different from other ideas in the market?
How will you use your strengths to make the idea successful?

Figure 4.3: Solving the decisiveness dilemma
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Let us look at Ankur’s entrepreneurial venture and
try to understand his decisiveness.
Ankur manufactures and sells towels in his village at
Dharamkot, Himachal Pradesh. For almost a year, his
towels would not get sold in his village. Disappointed,
he was about to shut down the business. That is when
someone suggested that he sell the towels in a city. He
showed some samples to people in Delhi. He realised
that the quality of towels and the price at which he was
producing was better suited for a city. The people in
his village found his products expensive. So, he started
producing softer towels for the city and cheaper ones for
his village. His customers in both the places were happy.
Can you analyse Ankur’s actions on four aspects of
decisiveness? Give an explanation for each aspect.
Example: Identifying opportunity — Ankur realised that
he could sell the towels in the city, as well as, his village.

Initiative
Initiative is the ability to take charge and act in a
situation before others. Once you have decided what
you want to do, the next step is taking action. There are
times when we recognise what action we have to take
but do not take it because we think we cannot do it. In
such times, it is important to reach out to people we are
working with to help us think about ideas and motivate
us to believe in our abilities.

TAKING
INITIATIVE

Realise that things are
in control and you can
take action in a given
situation.
Believe that you have
the ability to take
action in a situation.
Take action in
that situation!

Figure 4.4: Taking initiative
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Let us read story about Elton, who liked cutting and
styling people’s hair.
Elton was always interested in hairstyling. He knew
the latest international styles and would keep trying
them on his friends. But his family wanted him to work in
a software company. After years of struggling with what
to do, Elton spoke to his friends. They encouraged him
and made him realise that he should take charge as it
was his life. He gathered courage and spoke to his family.
He explained that he had the talent to style hair and the
skills to run an entrepreneurial venture because of what
he had learnt in school and at home about business.
His family was finally convinced and helped him set
up a salon. He is now well-known for his skills in and
around his town.
Discuss with your partner how Elton took the
initiative to start his venture. List the steps he had to
take to set it up.

Interpersonal skills
Interpersonal means dealing with relationships. It
is between two or more persons. Interpersonal skills,
thus, mean the competencies required to work with
other people.
In our everyday life, we are always talking to people
and working with them. Whether it is riding a bus or
sharing lunch in class, we are constantly interacting
with others. This is true for an entrepreneur as well.
Entrepreneurs work with people from different walks
of life. They might work with them because of their
talent and hard work. In such a case, the kind of people
who work in a team might be different. They might look
different, talk different and believe in different things. In
such a case, it becomes important for an entrepreneur,
as well as, every individual of the team to respect each
other and their differences.
Therefore, if the entrepreneur wants one’s business
venture to grow and do better, the person has to work
with a number of people. Thus, it becomes important
that we learn how to interact with people. Some ways to
do that are as follows.
Entrepreneurship Skills
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Listening
It is important to listen when someone talks. When
someone shares something, it is, generally, because the
person might have thought about it or it is how one
feels. Listening with interest to what someone is saying
helps build trust with the person.

Body language
How would you feel if someone had a frown on the face,
hands crossed and leaning back in the chair while
talking? If you cannot picturise it, tell someone in your
class to act it out and you shall know.
Our facial expressions, gestures and postures are
important while working with people. While listening,
if you show that you are interested in talking to the
person with a smile and leaning forward in the chair,
the person is likely to feel comfortable and talk more.

Positive attitude
Having a positive attitude, generally, implies being
optimistic about situations, interactions and oneself.
People with a positive attitude are hopeful and see the
best even in difficult situations. However, if you have
negative feelings, it is good to talk about it with someone
you trust and find out why you are feeling like that.
Having a positive attitude is important while
receiving and giving feedback. Feedback is giving
information or criticism to someone to say what can
be done to improve something. Feedback is important
in the communication process. Without feedback
no communication is complete. Therefore, during a
feedback conversation, it is important to speak in a
positive manner. One could start by talking about what
the person is doing well, and then, mention what one
can do better. In such a case, there are chances that
the other person will listen with interest. This applies
to you as well. It is important to stay open‑minded in a
feedback conversation
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Stress management

Notes

Have you ever been unable to sleep the night
before an exam because you were anxious
about how you would perform?
That state of
mental pressure or tension is called ‘stress’.
Sometimes, one experiences stress while working
with other people. Because there are people with
different personalities working in a team, it can lead
to stress for all. In such cases, managing stress
becomes important for the health and well-being of
everyone. Stress management refers to the different
ways to deal with stress, so as to feel healthy, positive
and refreshed.
There are many ways people deal with stress. Some
of them are as follows.
1. Taking a walk in nature
2. Doing a physical activity like running
swimming, etc.
3. Practising deep breathing exercises
4. Practising meditation or yoga

Perseverance
Perseverance is the ability to continue to do something,
even when it is difficult. Let us read about it through
Ravi’s story.
After 20 years of being a successful entrepreneur in
Lucknow, Ravi decided to move back to his village in
Jaunpur. In his village, he decided to open a clothing
store. He thought that because he had gained so much
success in the city, he would open the shop with the
same clothing style in the village as well.
Initially, some people came to try out his store’s
clothes but they said that the style did not match
what they wanted. They wanted more variety and
brighter colours.
Ravi was not disappointed. He decided to learn from
the failure. He sold off the old clothes to his friend in a
city and bought good quality clothes from a local seller.
He also put posters outside his shop, so that people
would feel welcome.
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After reading Ravi’s story, you can understand that
perseverance can be built in the following ways.

Perseverance
Not giving up when there is a
difficult situation
Working hard to achieve the goal

Analysing failures and learning from them
Figure 4.5: Building perseverance

Organisational skills
Organisational skills refer to the ability of making
optimal use of one’s time, energy and resources to achieve
one’s goals. Becoming better at these organisational skills
would help an entrepreneur become successful. So, let
us test these skills for ourselves. Organisational skills
include the following.

Time management
Time management is the process of planning and
following a conscious control of time spent on specific
activities. It is the ability to use one’s time well. Time
management includes the following.
1. Planning well
2. Setting goals
3. Setting deadlines
4. Giving important work responsibilities to
other people in a team
5. Conducting the most important tasks first
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Goal setting
A goal is somewhere we want to reach. It is the aim or
result that we want from an activity. Goal makes us
work harder, motivates us to complete what we start
and achieve the target. It gives us direction, and usually,
makes us put in more effort. The biggest difference
between the first and second round of a game you
played was that you had a goal for a second round. It is
that goal, which would have made you work harder and
smarter in the second round.

Efficiency
Efficiency is the ability to do things well, successfully,
without wasting time. In the second round of the game,
you would have utilised the abilities of your team
members better. You would have divided work among
your team members to be able to achieve the goal.
Efficiency can be achieved by using material, i.e., the
team’s efforts, money and time well.
For example, Sama runs a manufacturing business.
When she started, she would do everything —
manufacturing, transportation and selling the material
door-to-door. Now that her business has expanded, she
takes care of the manufacturing section only to ensure
that the quality of the material being used is maintained.
Her team members take care of the transportation and
sale of the manufactured products.

Managing quality
Managing quality in a business means setting and
maintaining a standard of excellence for products or
services being provided to customers. When the business
venture starts growing, maintaining quality becomes the
most important part because of the number of products
being produced every day. In Ravi’s story, even when
he bought clothes from a local seller, he did not buy
cheap ones. He bought good quality clothes because his
customers were important to him.

Entrepreneurship Skills
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Practical Exercise
Activity 1
Who am I?
Material required
Notebook, pen, etc.
Procedure
• In this activity, we talk about ourselves with
the rest of the class.
Pre-work
On the day before the exercise is conducted, each student has
to think about and select one person whom the student thinks
knows one well. Once the student has that person in mind, get
an object that represents the personality of the person to class.
It can be the person’s scarf, spectacles, bag, etc.
Instructions
1.
2.
3.

Place a chair in the centre of the class.
Each person comes in front of the class with the object
one has brought.
Each person shall use that object and stand behind
the chair. They have to act like the other person and
introduce themselves to the class. For example, if
Reshma chooses her mother as the person who knows
her best, she shall wear her dupatta, stand behind the
chair and introduce Reshma to the class. She shall
use these sentences like: “Reshma is my daughter.
She is 17 years old. She is a happy child”, etc. Every
person has two minutes to introduce oneself.

Tip: You are all going on a journey to know each other. So, it
becomes important to listen to each other with interest.
Activity 2
Group practice
Business ideas
Material required
Notebook, pen, etc.
Procedure
• In this activity, we shall come up with business ideas to
solve the problems of different people.
Instructions
1.
2.
3.
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Form groups of four.
Write about a person or people that you care about
and the problems they have.
Come up with solutions for those problems and write
them in the following table.
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Person
Problem
Ideas to solve
the problem
4.

Now, it is time to talk to your customers. Speak to the
people for whom you come up with solutions. Fill in
the table given below while speaking to them.
Name of the person
Do you have this
problem?
Does my idea solve your
problem? Do you have
suggestions to make my
idea better?
Is there anyone else who
is solving your problem?
What are they doing?

5.

Compare the ideas you have got from your customer
with the original idea. Come up with a new idea that
will be helpful to your customer.
6. Write down the strengths you have that will help
you to successfully execute this new idea. Write
them here.
		 My strengths .............................................
Activity 3
Group practice
Best out of waste
Material required
Notebook, pen, waste items for the activity, etc.
Procedure
• In this activity, let us make useful objects out of
waste material.
Pre-work
The students shall work in groups of five. Each group has to
bring any five items that have been lying as waste in their homes.
These five items should be such that an object can be made
out of them.
Instructions
1.
2.
3.

Divide yourselves into your groups of five. Place the
items you have brought on the bench.
Surprise time! You have to give your items to the team
next to you.
You, now, have 15 minutes to make a useful object
out of the material your team has.
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4.

After completion, each team shall get two minutes
to present one’s object before the class based on the
questions given below. Now, share your feelings on
successfully making an object.
• What was your original plan?
• How did you feel when your items were taken away
and a new set of items were given to you?
• How did you successfully complete the task and make
the object?
Activity 4

Pair and share
Let’s grow together!
Material required
Notebook, pen, etc.
Procedure
In this activity, we will talk and help each other become
better people.
Instructions
1.
2.
3.
4.

Find someone in class who knows you well.
Now, write down one thing that you see them do well.
Then, write down one thing that you feel they can
do better.
Now, share your opinion with each other, one‑by‑one.
You have five minutes to complete the activity.
Activity 5

Group practice
Snowball fight!
Material required
Notebook, pen, etc.
Procedure
• In this activity, we talk about a stress we have and
learn one method to deal with it.
Instructions
1. Close your eyes and spend two minutes just listening
to your breath.
2. After opening your eyes, write down a stressful feeling
you are having on a piece of paper. It can be about
your class, friends, home or anything else.
3. Crumple the sheet into a ball.
4. Now, gather in a circle and throw the paper balls at
each other. Laugh loudly — have fun!
5. Now, each person will pick up someone else’s ball and
read it out to the class.
Let’s exercise our interpersonal skills in this activity!
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Group practice
JAM — Just a Minute

Activity 6

Notes

Material required
Notebook, pen, etc.
Procedure
In this activity, let us see how much can we accomplish
in ‘Just a minute!’
Instructions
1. For the first round, take a pen and paper, and form
groups of five.
2. Prepare a list of things, which are either red or blue
in colour. You have one minute for this team activity.
3. Count the number of items you came up with in the
first round.
4. For the second round, write a goal on the top of your
team’s paper. Ensure this number is greater than
that of the first round. Example, if you had written
10 items as a team in round 1, try to set a goal of 15
items for round 2.
5. Now, write things, which are yellow or pink, in a
minute. Start!
6. What was the difference between round 1 and
round 2?
7. Were you able to achieve more in the second round?
If yes, why?
Activity 7
My entrepreneurial attitude
Material required
Notebook, pen, etc.
Procedure
• Here, the student and the person’s friend shall do an
activity on rating themselves for entrepreneurial qualities.
Instructions
1. Rate yourself on the following parameters (1 – lowest,
5 – highest).
• Interpersonal skills
• Taking initiative
• Decision making
• Hard work
• Time management
2. Now, with your friend, who knows you well, do the
activity. Ask your friend to rate you on each of the
above parameters.
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3.

Find your score.
• 5–11: you have some entrepreneurial attitude. You
need to work on your skills.
• 12–18: you are halfway there! There are some
qualities you are very good at but there are also some
you have to work on.
• 19–25: you are entrepreneurial already! Keep working
on your qualities.
4. After reading your rating and your friend’s rating,
discuss it with your teacher.

Check Your Progress
A. Match the situations to the type of attitude that an
entrepreneur is showing.
Situation

Attitude

(a) Aamir has been an entrepreneur (i) Decisiveness
for 15 years. His business has a
culture, where people working with
him are free to give feedback on
his work and share new ideas for
the business.
(b) Shanaya wants to start a sweet shop. (ii) Taking
initiative
After speaking to some people in her
area, she finds out that nobody sells
healthy sweets. She decides to make
non-fried sweets.
(c) Malvika has a book selling business. (iii) Interpersonal
skills
One day, a shipment of her books
gets lost. This creates a lot of
problems for her customers. She
apologises to them and works hard
for two days to get a new shipment
by the next day.
(d) Archana wants to start a 24×7
medical shop in her village.
However, she does not know
anything about medicines and has
doubts about her selling skills.
After talking to some people, she
realises how important it is. Finally,
she works with a pharmacist to set
up a medical store.

(iv) Perseverance

B. Short answer question
1.
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After taking your entrepreneurial report, you know
what you are good at and what can be improved upon.
How do you think you can improve? Write down three
steps that you shall take.
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Green Skills

Introduction
Today, we are experiencing unpredictable weather
conditions due to climatic changes and environmental
deterioration. Deterioration of the environment through
depletion of resources, such as air, water and soil is
taking place globally. Whether we work in a factory or
in field, we need to be aware of the factors and systems
that can be harmful to the environment. We must
adopt practices that are environment friendly and avoid
using processes that will harm our surroundings. For
example, pollution is a major problem in most cities.
We can check the rising pollution levels only if we are
aware of the various ways of controlling and minimising
it. We can plant trees near our houses, and use an
eco-friendly mode of transport, such as bicycle, electric
car, etc. We can take care of our environment in many
ways. For example, we must not leave the tap running
while brushing our teeth, use the leftover water in our
bottles for watering plants, use cloth bags instead of
plastic bags, buy eco-friendly products and reduce the
usage of paper.

Using non-toxic and natural products
for cleaning and washing
Cleaning products with sustainably sourced ingredients
and natural oils that are biodegradable and
available in eco-friendly packaging are conducive for
the environment.

2020-21

Using plants inside home and other
places for air purification
Plants, such as Areca palm and rubber absorb harmful
pollutants from the air.

Session 1: Green Jobs
A way we can contribute to the environment is by
encouraging green jobs. Green jobs help protect and
restore the environment. Green jobs could be in any
sector or industry — traditional sectors, such as
manufacturing and construction, and new sectors,
such as renewable energy.
A green job is defined as one that helps bring about
and maintain transition to environmentally sustainable
forms of production and consumption. It
cuts across all sectors — energy, material,
water conservation, waste management and
pollution control.
According to the United Nations
Environment Program (UNEP), green jobs or
green collar jobs are works in agricultural,
administrative, research and development,
manufacturing and service activities that
contribute substantially to preserving or restoring
environmental quality. ‘Environmental quality’ is a set
of properties and characteristics of the environment,
either generalised or local, as they impinge on human
beings and other organisms.
A green collar worker is one who is employed in
the environmental sectors of the economy. Green
collar workers include professionals, such as green
building architects, environmental consultants, waste
management or recycling managers, environmental
or biological systems engineers, landscape architects,
solar and wind energy engineers and installers, green
vehicle engineers, organic farmers, environmental
lawyers and business personnel dealing with
green services or products. Green workers include
electricians who install solar panels, plumbers who
install solar water heaters, construction workers who
build energy-efficient green buildings, technicians
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and workers involved in establishing wind power
farms, and those working for clean and renewable
energy development.
At the enterprise level, green jobs can produce
goods or provide services that benefit the environment,
for example, green buildings or clean transportation.
However, these green outputs (products and services)
are not always based on green production processes
and technologies. Therefore, green jobs can also be
distinguished by their contribution to more environment
friendly processes. For example, green jobs can reduce
water consumption or improve recycling systems.
India has adopted several measures for ensuring
sustainability, renewable energy and energy efficiency
in various sectors, for example, efforts are being
made to reduce Carbon dioxide emission rates from
vehicles in automotive sector, promoting use of nonfossil fuel (solar, hydro and wind) as energy sources
for power generation in the power sector and enabling
energy efficient technologies through the concept of
green buildings in the construction sector.
The government, in association with private
players, is also raising energy awareness, changing
consumer behaviour, setting energy codes, and
evolving energy efficiency design and technologies.
To address the skilled workforce issues associated
with sustainable development, the Ministry of Skill
Development and Entrepreneurship has set up the
‘Skill Council for Green Jobs’. It is working towards
developing competencies of people in the domain
of renewable energy, sustainable development and
waste management.
Green jobs that exist over an array of occupational
profiles of skills and educational backgrounds
constitute entirely new type of jobs, but most build
on traditional professions and occupations.
With the aim of providing a greener economy
and creating environment friendly employment
opportunities, the government is also providing
impetus for green jobs as part of restructured growth
strategies under its ‘Make in India’ campaign. ‘Make
in India’ is designed to facilitate investment, ensure
Green Skills
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India’s first modern
metropolitan rail transport
system, Delhi Metro, not only
has helped commuters in Delhi
save on commuting time per
day but has also become the
first rail‑based methodology
to garner 90,000 voluntary
carbon credits for improving
energy efficiency. It has not
only created jobs for engineers,
drivers, station attendants,
signal staff, ticketing,
construction and maintenance
workers but also resulted in
greening existing occupations
and creating new occupations.

faster innovation, enhance skill development,
protect intellectual property and build best in
class manufacturing structures.

Benefits of green jobs
The greening of economy presents a major
opportunity to start new businesses, develop
new markets and lower energy costs. Green jobs
that contribute to protecting the environment
and reducing carbon footprint are becoming a
key economic driver of the twenty-first century.
Green jobs help:
• increase the efficiency of energy and
raw material.
• reduce greenhouse gas emissions.
• control waste and pollution.
• protect and restore ecosystems.
• support adaptation to the effects of
climate change.

Green jobs in agriculture
Organic gardening and farming is the process by which
we can grow plants and crops in an environment
friendly way. It prevents toxic runoff as no synthetic
pesticides are used. It prevents water pollution and soil
contamination as no chemical is added
to the soil. By using organic methods
of gardening, one can prevent death of
insects, birds, critters and other beneficial
soil organisms. Organic fruits and
vegetables are free from chemical residues
of synthetic fertilisers, and hence, are good
for our health.
Farmers’ cooperatives are one of the
most effective means of reducing the
risk in agriculture and strengthening the
livelihoods of small and marginal farmers. The process
involves mobilising farmers into groups of 15–20
members at the village level (called Farmer Interest
Groups or FIGs) and building their associations to an
appropriate federating point, i.e., Farmer Producer
Organisations (FPOs). FPOs are farmers’ collectives
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with membership consisting mainly of small or
marginal farmers.
Some green jobs in the agriculture sector are in
organic farming, integrated pest management, farm
mechanisation and agriculture tourism. The Krishi
Vigyan Kendras (KVKs) set up by the government,
can be utilised to provide support activities like
technology dissemination, training awareness to
the local youth and farmers for collection, storage
and reuse of agro-waste.

Green jobs in transportation
Use of energy-efficient vehicles and alternate fuels like
Compressed Natural Gas (CNG) can help minimise
greenhouse gas emissions. The new biofuel Policy
announced by the Government of India on 10 August 2018
focusses on initiatives for enhanced use of biomass so as
to improve the availability of ethanol through starch and
sugar‑based feedstock, develop ethanol technologies
and increase the production of biodiesel for blending.
Biofuels produced directly or indirectly from organic
material, including BioCNG, Bio-methanol, etc., can
generate green jobs.
The Energy Efficiency Services Limited (EESL),
under the Ministry of Power, has launched an ‘electric
vehicle programme’, which aims towards offering a
comprehensive solution to facilitate the adoption of
disruptive technology in India. The EESL seeks to
create market for electric vehicle, a technology poised
to boost e-mobility in the country. These encompass
road, rail, sea and air based vehicles that use electric
drive and take electric charge from an external source,
or hydrogen in case of fuel cell electric vehicle. Some
electric vehicle technologies are hybridised with fossil
fuel engines (for example, plug-in hybrid electric
vehicles, or PHEVs), while others use only electric power
via a battery (battery electric vehicles). The emergence
of electric drives as an alternate to internal combustion
engines has opened opportunities for new entrants in
the automotive market. Skill training of entrepreneurs
in handling and maintenance of e-rickshaws can create
more green jobs in the transportation sector.
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Green jobs in water conservation
There are green jobs in water harvesting and
conservation. Rooftop rainwater harvesting refers to the
process where rainwater is collected in tanks to be used
later. It can be installed in all houses and buildings. It
can also help increase the water table. Cycle‑run water
pumps are being used instead of electricity‑run pumps.
These do not consume electricity and provide a way for
people to exercise.
Some common green jobs in the agriculture sector
are related to water quality testing, water conservation,
water management, etc.
Using bamboo channels for drip irrigation is an
eco-friendly way to irrigate the land. It uses water
efficiently without any wastage. It is cheaper to build,
and after 2–3 years when the bamboo rots, it can be
added to the soil as manure.

Green jobs in solar and wind energy
Solar and wind power plants
provide clean energy. A Solar
Photovoltaic Installer installs
and maintains solar panels
in homes, businesses or land.
A solar lighting technician
assembles, tests and repairs
different
types
of
solar
photovoltaic home lighting
system and streetlights. Some
common jobs in this sector are roofer, solar panel
installation technician and field technician.
Green news
India is one of the
few countries where
forest and tree cover
has increased in
recent years. The
total forest and tree
cover is 24 per cent
of the country’s
geographical area.

Green jobs in eco-tourism
Eco-tourism is intended to provide an experience to
visitors to understand the importance of conserving
resources, reducing waste, enhancing the natural
environment and reducing pollution. This helps improve
public image as the visitors feel good about being in an
environment friendly place. Green jobs in eco‑tourism
include eco‑tour guides and eco‑tourism operators.
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Green jobs in building and construction
Houses and buildings are becoming environment friendly.
They use sustainable building material, and follow ecofriendly construction processes and green operations.
Green building design provides an integrated approach
to utilisation of renewable and non-renewable resources.
It is important that future green building programmes
and projects are established with strategies to address
skill issues, including appropriate training. Skill
development has a strategic role to play in promoting the
development of green buildings. It is essential that there
are enough workers equipped with appropriate skills so
as to ensure that green buildings are developed on a
large scale. Areas for green jobs in this sector include
construction, landscape, gardening, maintenance of
green components, water management, etc.

Green news
The Indian Green
Building Council
(IGBC), part of the
Confederation of
Indian Industry (CII),
was founded in the
year 2001. The IGBC
offers services, which
include developing
new green building
rating programmes,
certification services
and green building
training programmes.

Green jobs in solid waste management
Solid waste is defined as any discarded solid fraction,
generated from domestic units, trade centres,
commercial establishments, industries, agriculture,
institutions, public services and mining activities.
The Ministry of Urban Development, Government of
India, has classified solid waste in 14 categories based
on the source of origin and type of waste, i.e., domestic,
municipal, commercial, industrial, institutional,
garbage, ash, street sweepings, dead animals,
construction and demolition waste, bulky, hazardous
and sewage waste.
Solid waste management system includes collection,
segregation, transportation, processing and disposal of
waste. Green jobs related to waste management are in
areas like e-waste recycling, solid waste management,
waste reduction, waste auditing, waste control, etc.

Green jobs in appropriate technology
Appropriate technology is small-scale technology
that is environment friendly and suited to local
needs. Examples of appropriate technology are
bike-powered or hand-powered water pumps, solar lamps
in streetlights, solar buildings, etc. It is the simplest
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Notes

technology that can get a job done in an environment
friendly manner with locally available resources. The
green jobs in appropriate technology may include areas,
such as biogas production, water treatment filtration,
farm mechanisation, rainwater harvesting, sanitation,
lighting, food production, refrigeration, etc.

Practical Exercise
Activity
Group discussion
Green jobs
Material required
Pen, paper, etc.
Procedure
• Form groups, depending on the number of students
present in a class.
• Every student will describe one green job that one would
like to do. Each one of them will make a list and share it
with the rest of the class.

Check Your Progress
A. Multiple choice questions
Read carefully all questions given below and choose the
correct option.
1. Rita’s children fall sick very often. They have cold and
cough every month. What should Rita do?
(a) Grow organic food in kitchen garden
(b) Use air purifiers with HEPA filters
(c) Keep them inside the house all the time
(d) Paint her house with non-VOC paint
2. Jaanvi’s children have grown up. They have a lot of
clothes that are too small for them now. What should
Jaanvi do with these old clothes?
(a) Throw them in the trash can
(b) Burn them
(c) Keep using them even though they are too small
(d) Donate them or make bags out of them
B. Short answer question
1. Name any two green jobs in the following sectors.
(i) Construction
(ii) Renewable energy

What Have You Learnt?
After completing this Session, you will be able to:
• identify green jobs in various industries and sectors.
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Session 2: Importance

of

Green Jobs

Notes

You have learnt that jobs are understood as green when
people working in these areas help reduce adverse
environmental impacts, and help build environmentally,
economically and socially sustainable enterprises
and economies.

Limiting greenhouse gas emissions
Some of the greenhouse gases are Carbon dioxide,
methane, Nitrous oxide, ozone and chlorofluorocarbons
(CFCs). These are emitted due to burning of fossil
fuels, using vehicles and refrigerants, and carrying out
agricultural activities, etc. These gases can trap heat
from the earth and prevent it from escaping into outer
space. This causes the earth to heat, leading to ‘global
warming’. To reduce the emission of greenhouse gases,
people are working towards reducing the use of fossil
fuels by finding less polluting energy sources, such as
Compressed Natural Gas (CNG).

Minimising waste and pollution
Instead of only thinking about how to recycle or reuse
waste, we must work towards finding solutions on how
to reduce the amount of waste produced. This will help
in waste management.
In manufacturing plants and factories, managers try
to find various ways to reduce the amount of waste
produced at every step of the process. Here are some of
the ways.
• Reusing scrap material
For example, in paper mills, damaged rolls are
sent back to the beginning of the production
line, i.e., they are added as raw material. In
manufacture of plastic items, off-cuts and scrap
are re-incorporated into new products.
• Ensuring quality control
If the quality of products is maintained, there will
be a decrease in rejected products, thus, reducing
waste. Automated monitoring equipment are now
being used, which can help identify production
problems at an early stage.
Green Skills

119

2020-21

Notes

•

Waste exchange
This is where the waste product of one process
becomes the raw material for another. It
represents the way of reducing waste disposal
through re‑use.

•

Managing e-waste
With advanced technology, we have also
encountered problems in managing e-waste like
old mobile phones, laptops and television sets.
It is important to have sustainable development
and plan judiciously for recycling e-waste.

•

Use of eco-friendly material
Scientists have discovered various material,
which are eco-friendly, for example, banana leaf
and paper plates that are easily disposable, etc.
These must be made easily available and their
use needs to be encouraged.

Protecting and restoring ecosystems
Ecosystem is the community of living and non-living
beings existing together, and interacting with and
supporting each other. It is the perfect balance where
every species can survive. Human activities, such
as excess felling of trees can lead to destruction of
the ecosystem, causing climate change and natural
disasters, making it difficult for living beings to survive.
People are working now to help conserve the
existing ecosystems and restore the degraded ones,
using natural solutions. Forests and vegetation help
stabilise slopes, and therefore, reduce the risk of
landslides. Wetlands can help control floods. Avoiding
cutting of forests, planting more trees, investing in
soil health and restoration can control the emission of
greenhouse gases.

Adapting to the effects of climate change
Climate will change based on the damage already done.
Even though people are trying to control the emission
of greenhouse gases, global warming will be there due
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to the damage already done in terms of felling of trees
and using land for agriculture, etc. So, we have to adapt
to those changes. This means, we must find ways to
survive in the new climatic conditions. For example, if
there is weather forecast of less rain, farmers will need
to grow crops that can survive in drought conditions.
The Government of India launched the National
Action Plan on Climate Change (NAPCC) in June 2008
to deal with climate change and related issues. The
NAPCC comprises eight missions in specific areas of
solar energy, enhanced energy efficiency, habitat, water,
sustaining Himalayan ecosystems, forestry, agriculture
and strategic knowledge for climate change, which
address issues relating to mitigation of greenhouse
gases and adaptation to the adverse impacts of climate
change on environment, forests, habitat, water resources
and agriculture.

Notes

Practical Exercise
Activity 1
Poster making
Material required
Chart paper, colour pencils, pictures, etc.
Procedure
• Form groups depending on the number of children present
in a class.
• Collect pictures of green jobs and make a poster. Organise
an exhibition in the front gate of your school.
Activity 2
Tree plantation
Material required
Seeds, soil, water, gloves, etc.
Procedure
• Identify an area where you can plant a sapling.
Coordinate with your teacher for the kind of plant that
can thrive at the selected location. For example, there
are various plants that require less water. Now, plant a
suitable seed or sapling. Name it if you want. Make sure
that you water the plant regularly and take care of it.
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Check Your Progress
A. Multiple choice questions
Read carefully the questions given below and choose the
correct option(s).
1. There is a garbage bin in your canteen and it, generally,
gets filled beyond capacity every day. What should
you do?
(i) Ask the canteen management to get a bigger bin
(ii) Suggest ways to reduce the amount of
garbage collected
(iii) Throw garbage on the floor and walk away
(iv) Talk to your friends about the problem
(a) (i), (ii), (iii)
(b) (i), (ii)
(c) (i), (iii), (iv)
(d) (i), (iv)
2. In a steel factory, a lot of utensils are being made. The
manager finds a number of defective pieces, which have
to be discarded. How can the person minimise the waste?
(a) Give it to kabaadiwala or scrapdealer
(b) Dump it in a landfill site
(c) Send it back to the production line — to be melted
(d) Sell it in market
B. Short answer questions
1. List some ways by which we can reduce the amount of
waste generated.
2. Explain the importance of green jobs in reducing the
emission of greenhouse gases.

What have you learnt?
After completing this Session, you will be able to:
• explain the role and importance of green jobs.
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Answer Key
Unit 1: Communication Skills
Session 1: Active Listening
A. Multiple choice questions
1. (b)

2. (a),

3. (c)

4. (d)

Session 2: Parts of Speech
A. Multiple choice questions
1. (b)

2. (d)

3. (d)

B. Fill in the blanks
(a) The boy is running.
(b) The girls are skipping.
(c) The girl is riding.
(d) Raju is drinking milk.
(e) The boy is studying.
(f) The dog is barking.
Session 3: Writing Sentences
A. Multiple choice questions
1. (a)
2. (d)
3. (d)

4. (b)

Unit 2: Self-management Skills
Session 3: Self-awareness
A. Multiple choice questions
1. (a)

2. (a)

3. (a)

4. (d)

Unit 3: Information and Communication Technology Skills
Session 1: Getting Started with Spreadsheet
A. Multiple choice questions
1. (a)

2. (b)

3. (d)

4. (c)

Session 2: Performing Basic Operations in a Spreadsheet
A. Multiple choice questions
1. (b)

2. (c)

Session 3: Working with Data and Formatting Text
A. Multiple choice questions
1. (b)
2. (a)
3. (d)

4. (d)

Session 4: Advanced Features in Spreadsheet
A. Multiple choice questions
1. (b)
2. (b)
3. (c)
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5. (c)

Session 5: Presentation Software
A. Multiple choice questions
1. (c)
2. (c)
3. (b)
Session 6: Opening, Closing, Saving and Printing a Presentation
A. Multiple choice questions
1. (a)
2. (c)
3. (c)
Session 7: Working with Slides and Text in a Presentation
A. Multiple choice questions
1. (c)
2. (c)
3. (a)
Session 8: Advanced Features used in Presentation
A. Multiple choice questions
1. (d)
2. (c)
3. (c)
Unit 4: Entrepreneurship Skills
Session 1: Entrepreneurship and Entreprenur
A. Multiple choice questions
1. (b)
2. (b)
3. (a)
Session 2: Barriers to Entrepreneurship
A. Match the situations in the columns to the
meaning of the word
a. (iii)

b. (i)

c. (ii)

B. Multiple choice questions
1. (b)

2. (b)

3. (a)

Session 3: Entrepreneurial Attitudes
A. Multiple choice questions
1. (c)
2. (b)
3. (b)
Session 4: Entrepreneurial Competencies
A. Match the situations to the type of attitude
that the entrepreneur is showing
a. (iii)
b. (i)
c. (iv)
d. (ii)
Unit 5: Green Skills
Session 1: Green Jobs
A. Multiple choice questions
1. (b)
2. (d)
Session 2: Importance of Green Jobs
A. Multiple choice questions
1. (b)

2. (c)
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Glossary
Ability: is the physical and mental skill to do something.
Active cell: is the one that is selected.
Alignment: refers to the arrangement of text (left, right or
center aligned).
Attitude: is a way of thinking or feeling about something.
Barrier: refers to a problem, rule or situation that prevents
somebody from doing something, or makes something impossible.
Bold text: means making a text darker and thicker.
Capital: refers to the money available for starting a
business venture.
Cell: is the place where a row and column intersect.
Cell range: is a range of cells that are selected.
Column: refers to the vertical arrangement of cells.
Competence: refers to the ability to do something well.
Decisiveness: refers to the ability to make the right decisions at the
right time.
Digital presentation: is a presentation made on a computer using
a software, which has text, images, video and audio, and various
other features to make it attractive.
Efficiency: is the ability to do things accurately, successfully and
without wasting the available resources.
Feedback: is an advice, criticism or information about how good or
useful something or somebody’s work is. It aims to help someone
improve one’s work.
Filter: refers to filtering data, which means selecting and displaying
few records out of the total list.
Formatting text: refers to changing the look, size, colour, etc., of
the text.
Formula Bar: is the place, where data or formula can be entered in
the selected cell.
Goal: is the aim or target one wants to achieve.
Initiative: is the ability to take charge and act in a situation
before others.
Interpersonal: is connected with relationships between
two people.
Interpersonal skills: are the competencies required to work with
two and more people.
Italicise text: means making the text appear slanting to
the right.
Layout: is the arrangement of text, images, shapes, etc.,
on a slide.
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Operator: is the symbol used in a computer to perform
mathematical functions, such as addition(+), subtraction(-),
multiplication(×) and division(÷)
Opportunity: is a chance to do something, generally, the right time
or moment to do something.
Organisational skills: are the ability to use one’s time, energy and
resources well to be able to achieve one’s goals.
Perseverance: is the ability to continue to do something, even when
it is difficult.
Risk: is a situation, which has a chance of failure.
Row: is a horizontal arrangement of cells.
Sorting data: means arranging data in a particular order, for
example in alphabetical order.
Stress: refers to the state of mental pressure, tension or anxiety.
Stress management: includes techniques aimed at controlling
a person’s stress level so that the person feels healthy and
positive again.
Underline text: means drawing a line under the text.
Venture: is a new business activity that, usually, involves risks.
Wrap text: means adjusting the text within a cell so that it is fully
visible without changing the column size.
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